
Data-Services

Astera Software

Sep 24, 2023





GETTING STARTED

1 Astera API Management – System Requirements 1

2 Astera API Management – Product Architecture 3

3 Installing Client and Server Applications 5

4 Connecting to an Astera API Management Server using Lean Client 15

5 How to Connect to a Different Astera API Management Server from the Lean Client 19

6 How to Build a Cluster Database and Create Repository 21

7 How to Login from Lean Client 27

8 How to Verify Admin Email 31

9 Configuring the Deployment Directory in Astera API Management 37

10 API Publishing 41

11 API Consumption 183

i



ii



CHAPTER

ONE

ASTERA API MANAGEMENT – SYSTEM REQUIREMENTS

Note: The overall speed and performance of the application depend on the configuration of your machine. More
memory and higher processing speed on the system will result in faster performance, especially when transferring
large amounts of data as the application takes advantage of the multicore hardware to parallelize operations.
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CHAPTER

TWO

ASTERA API MANAGEMENT – PRODUCT ARCHITECTURE

Astera API Management is built on a client-server architecture. The client is the part of the application which a user can
run locally on their machine, whereas the server performs processing and querying requested by the client. In simple
words, the client sends a request to the server, and the server, in turn, responds to the request. Therefore, database
drivers are installed only on the Centerprise server. This enables horizontal scaling by adding multiple clients to an
existing cluster of servers and eliminating the need to install drivers on every machine.

The Astera API Management client and server applications communicate on REST architecture. REST-compliant
systems, often called RESTful systems, are characterized by statelessness and separate concerns of the client and
server, which means that the implementation of both can be done independently if each side knows what format of
messages to send to the other. The server communicates with the client using HTTPS commands, which are encrypted
using a certified key/certificate signed by an authority. This saves the data from being intercepted by an attacker as the
plaintext is encrypted as a random string of characters.
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CHAPTER

THREE

INSTALLING CLIENT AND SERVER APPLICATIONS

In this section, we will discuss how to install and configure Astera API Management Server and Centerprise Lean
Client applications.

3.1 How to Install Data Services Server

1. Run ‘DataServicesServer.exe’ from the installation package to start the server installation setup.

2. You’ll be directed to the welcome screen. Click Next to continue.

3. On the next screen you will see the license agreement. You can only continue if you choose to accept the terms of
the license agreement. Click Next to continue.
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4. On the next screen, enter the user details and click Next to continue.

5. Select the type of installation (Complete or Custom) you want to proceed with and click Next.

6 Chapter 3. Installing Client and Server Applications
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6. Select Install to complete the installation.

7. Select Finish to finish the installation process.

3.1. How to Install Data Services Server 7
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3.2 How to Install Centerprise Lean Client

1. Run the ‘CenterpriseDataIntegrator’ application from the installation package to start the client installation setup.

2. You’ll be directed to the welcome screen. Click Next to continue.
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3. On the next screen you will see the license agreement. You can only continue if you choose to accept the terms of
the license agreement. Click Next to continue.

3.2. How to Install Centerprise Lean Client 9
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4. On the next screen, enter the user details and click Next to continue.

5. Select the type of installation (Complete or Custom) you want to proceed with and click Next.

10 Chapter 3. Installing Client and Server Applications
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If you select custom installation, you can choose specific component(s) that you want to download.

3.2. How to Install Centerprise Lean Client 11
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We want to install the complete package therefore, We’ll select Complete on the Setup Type screen and click Next.

6. Select Install to complete the installation.

12 Chapter 3. Installing Client and Server Applications
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7. Select Finish to finish the installation process.

3.2. How to Install Centerprise Lean Client 13
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This is how you install Astera API Management Server and Centerprise client applications. The next step is to establish
a connection between the client and server.

14 Chapter 3. Installing Client and Server Applications
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FOUR

CONNECTING TO AN ASTERA API MANAGEMENT SERVER USING
LEAN CLIENT

After you have successfully installed Centerprise client and Astera API Management server applications, open the
client application and you will see the Server Connection screen as pictured below.

Enter the Server URI and Port Number to establish the connection.

The server URI will be the IP address of the machine where Astera Data Services Server is installed.

Server URI: (HTTPS://IP_address)

Note: You can get help of your network administrator to get the IP address of the machine where Astera API Man-
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agement Server is installed. Or you can launch the command prompt and type the command ipconfig to get the IP
configuration details for the machine and use that information to provide Server URI.

The default port for the secure connection between the Lean client and Astera API Management Server is 9263.

If you have connected to any server recently, you can automatically connect to that server by selecting that server from
the Recently Used drop-down list.

Click Connect after you have filled out the information required.

The client will now connect to the selected server. You should be able to see the server listed in the Server Explorer
tree when the client application opens.

To open Server Explorer go to Server > Server Explorer or use the keyboard shortcut (Ctrl + Alt + E).

16 Chapter 4. Connecting to an Astera API Management Server using Lean Client
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The yellow icon with an exclamation mark means that the server is not configured. Before you can start working with
the Centerprise Lean client, you will have to create a repository and configure the server.
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CHAPTER

FIVE

HOW TO CONNECT TO A DIFFERENT ASTERA API MANAGEMENT
SERVER FROM THE LEAN CLIENT

You can connect to different servers right from the Server Explorer window in Lean Client. Go to the Server Explorer
window and click on the Connect to Server icon.

A prompt will appear that will confirm if you want to disconnect from the current Server and establish a connection to
a different server. Click Yes to proceed.

Note: A client cannot be connected to multiple servers at once.

You will be directed to the Server Connection screen. Enter the required server information (Server URI and Port
Number) to connect to the server and click Connect.
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If the connection is successfully established, you should be able to see the connected server in the Server Explorer
window.

20 Chapter 5. How to Connect to a Different Astera API Management Server from the Lean Client
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SIX

HOW TO BUILD A CLUSTER DATABASE AND CREATE REPOSITORY

Before you start using the Astera API Management server, a repository must be set up. Astera Server supports SQL
Server and PostgreSQL for building cluster databases, which can then be used for maintaining the repository. The
repository is where request logs, request queues, and deployment information is stored.

To see these options, go to Server > Configure > Step 1: Build repository database and configure server.

The first step is to point to the SQL Server or PostgreSQL instance where you want to build the repository and provide
the credentials to establish the connection.
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Note: The Astera API Management Server will not create the database itself, just the tables. A database will have to
be created beforehand or an existing database can be used. We recommend the Astera API Management Server to have
its own database for this purpose.

6.1 Building a Repository on SQL Server

1. Go to Server > Configure > Step 1: Build repository database and configure server.

2. Select SQL Server from the Data Provider drop-down list and provide the credentials for establishing the connection.

3. From the drop-down list next to the Database option, select the database on the SQL instance where you want to
host the repository.

22 Chapter 6. How to Build a Cluster Database and Create Repository
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4. Click Test Connection to test whether the connection is successfully established or not. You should be able to see
the following message if the connection is successfully established.

6.1. Building a Repository on SQL Server 23
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5. Click OK to exit out of the test connection window and again click OK, the following message will appear. Select
Yes to proceed.

The repository is now set up and configured with the server to be used.

The next step is to log in using your credentials.

24 Chapter 6. How to Build a Cluster Database and Create Repository
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6.2 Building a Repository on PostgreSQL

1. Go to Server > Configure > Step 1: Build repository database and configure server.

2. Select PostgreSQL from the Data Provider drop-down list and provide the credentials for establishing the con-
nection.

3. From the drop-down list next to the Database option, select the database on the PostgreSQL instance where you
want to host the repository.

4. Click Test Connection to test whether the connection is successfully established or not. You should be able to see
the following message if the connection is successfully established.

6.2. Building a Repository on PostgreSQL 25
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5. Click OK and the following message will appear. Select Yes to proceed.

The repository is now set up and configured with the server to be used.

The next step is to log in using your credentials.

26 Chapter 6. How to Build a Cluster Database and Create Repository
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SEVEN

HOW TO LOGIN FROM LEAN CLIENT

Once you have created the repository and configured the server, the next step is to login using your Astera Centerprise
Client account credentials.

You will not be able to design any API flows on the Lean client if you haven’t logged in. The options will be disabled.

7.1 Log in to your user account

1. Go to Server > Configure > Step 2: Login as admin.
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2. This will direct you to a login screen where you can provide your user credentials.

If you are logging in for the first time, you can login using the default credentials as follows: Username: admin
Password: Admin123

After you log in, you will see that the options in the Centerprise Lean Client are enabled.

You can use these options until your trial period is active. For fully activating the options and the product, you’ll have
to enter your license.

7.2 How to automatically reconnect on client startup

If you don’t want Centerprise to show you the server connection screen every time you run the client application, you
can skip that by modifying the settings.

To do that go to Tools > Options > Client Startup and select the Auto Connect to Server option. On enabling the option,
Centerprise will store the server details you entered previously and will use those details to automatically reconnect to
the server every time you run the application.

28 Chapter 7. How to Login from Lean Client
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The next step after logging in is to unlock Centerprise using the License key.

7.2. How to automatically reconnect on client startup 29
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CHAPTER

EIGHT

HOW TO VERIFY ADMIN EMAIL

Once you have logged into the Astera Centerprise client, you can set up an admin email to access the Centerprise server.
This will also allow you to be able to use the “Forgot Password” option at the time of log in.

In this document, we will discuss how to verify admin email in Astera Centerprise.

8.1 Verifying Admin Email

1. Once logged in, we will now proceed to enter an email address to associate with the admin user by verifying the
email address.

Go to Server > Configure > Step 3: Verify Admin Email

2. Unless you have already set up an email address in the Mail Setup section of Cluster settings, the following dialogue
box will pop up asking you to configure your email settings.
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Click on Yes to open your cluster settings.

Click on the Mail Setup tab.

3. Enter your email server settings.

32 Chapter 8. How to Verify Admin Email
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4. Now, right-click on the Cluster Settings active tab and click on Save & Close in order to save the mail setup.

5. Re-visit the Verify Admin Email step by going to Server > Configure > Step 3: Verify Admin Email.

This time, the Configure Email dialogue box will open.

8.1. Verifying Admin Email 33
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6. Enter the email address you previously set up and click on Send OTP.

7. Use the OTP from the email you received and enter it in the Configure Email dialogue and proceed.

On the correct entry of the OTP, an email successfully configured dialogue will appear.

8. Click OK to exit it. We can confirm our email configuration by going to the User List.

Right-click on DEFAULT under Server Connections in the Server Explorer and go to User List.

9. This opens the User List where you can confirm that the email address has been configured with the admin user.

34 Chapter 8. How to Verify Admin Email
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8.2 Using Forgot Password feature

The feature is now configured and can be utilized when needed by clicking on Forgot Password in the log in window.

This opens the Password Reset window, where you can enter the OTP sent to the specified e-mail for the user and
proceed to reset your password.

8.2. Using Forgot Password feature 35
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This concludes our discussion on verifying admin email in Astera Centerprise.

36 Chapter 8. How to Verify Admin Email
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NINE

CONFIGURING THE DEPLOYMENT DIRECTORY IN ASTERA API
MANAGEMENT

Before API deployments can be created in Astera API Management, the deployment directory must be defined. It is
used to maintain runtime executable archives of all the deployments made on the server.

Without defining the deployment directory, creating a deployment will produce an error, asking the user to set the
directory, in the Job Progress window.

1. Right-click on the cluster’s node in the Server Explorer window and select Cluster Settings from the context menu.
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This will open a new tab.

38 Chapter 9. Configuring the Deployment Directory in Astera API Management
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Deployment Directory – Path: This is where we browse and add a location for our deployment directory.

As you can see above, the directory has been set.

Note: The directory can be set from both local and remote locations.

2. Now, save the Cluster Settings to enable deployment generation on the server.

This concludes our discussion on the configuration of the deployment directory in Astera API Management.
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TEN

API PUBLISHING

10.1 Designing an API Flow

10.1.1 What is an API Flow?

An API flow is an artifact to design a data or a function service endpoint incorporating various data connectors, trans-
formations, quality checks, task-based operations, integrating services, and much more. It defines an end-to-end flow
for processing an input, applying transformations and integrations, and routing to response definitions.

Astera API Management holds the ability to create an API Flow as a REST endpoint by defining its request and response
objects with in-built abilities to apply sort, filter, pagination, and error handling on responses.

10.1.2 Creating an API Flow

Let’s see how we can create API flows contained in a project:

1. To create an API Flow, navigate to the main toolbar, select Project, and click on it. Then, hover over New and select
a project type. API Flows can only be deployed from a project, but they can be added to any project type.

2. Once the project is created, head to the Project Explorer. Right-click on any of the folders in the project and select
Add New REST API.
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By default, your API Flow file will contain the two required objects, REST Request~~,~~ and REST response, which
act as start and stop objects for an API flow. This flow will be saved with a .API extension.

Configuring the REST Request Object

The REST Request object is used to define the request endpoint resource, input parameters, and message payloads
expected from the API user which would then be used in the flow processing.

1. To start, right-click on the object and select Properties from the context menu.

42 Chapter 10. API Publishing
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Once done, the parameter configuration window will open.

Here, you can define all the expected parameters from the request. To define a parameter, specify a name, location, and
the data type.

Name: To define the name of the parameter.

10.1. Designing an API Flow 43
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Parameter Location: Here, the location of the parameter is selected between either URI, Query, or Header.

Data Type: To define the parameter’s data type expected from the request. Sending an incorrect data type would result
in a 400 BadRequest error response.

Default Value: Add a default value, if any, to be used for optional query or header parameters when the incoming
request is missing these parameters.

Parameter Description: These will be used in the auto-generated Open API Swagger specification.

Required: This checkbox is selected if the parameter must be included for a request to be valid. The API returns a
400-Bad Request error response if required parameters are not provided.

2. Once done, select Next, and the API Configuration screen will appear.

44 Chapter 10. API Publishing
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HTTP Configuration for REST Request Object

HTTP Method: There are five methods based on which the request object can be configured. The method depends on
the resource operation happening in the flow. These options are,

1. Get: Used when the flow is fetching data from a resource based on the given request parameters.

2. Delete: Used when the flow deletes an object based on the given request parameters.

3. Post: Used to create a new object resource. In addition to request parameters, the POST method also allows a request
payload which can be defined as the input layout.

4. Put: Used to update an existing resource. It also allows input parameters and a payload in the request definition.

5. Patch: This method qualifies to partially update an existing resource. It also allows input parameters and a payload
in the request definition.

Note: For this demonstration, we will be configuring a GET API flow.

Resource: The resource entity for the REST API operation. It becomes part of the request URL. Here, since we are
designing an API to read order items, we will call our resource “OrderItems”.

10.1. Designing an API Flow 45
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Note: Nested resources can also be defined using a /.

Example URL: It displays the complete request URL formed with the appended resource and parameters.

Published Description: A description for the API operation on the given resource. You could use the default generated
description or modify it to your own description. This description for the API endpoint will be used in the auto-
generated Open API Swagger specification.

46 Chapter 10. API Publishing
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Show Advanced Fields: Enabling this will display additional information fields in the requestinfo node. These include
information about the incoming request that can be further used in the API flow, such as connection, local address,
local port, IP Address, etc.

Show User Context Fields: Enabling this will display user profile fields from the incoming request in the requestinfo
node. These fields show information such as username, email address, whether the user is locked out or not, etc.

Synchronous: API request executes synchronously such that an API call blocks and returns to the client only when a
response from the server is ready.

Asynchronous: To deploy the API as an asynchronous operation. This implies that the requestee does not need to wait
for the response to be processed. On making a request, the server responds with a 202 Accepted message and starts to
process. The client can periodically check the status and read the response when available.

To learn more about Synchronous and Asynchronous, click here.

10.1. Designing an API Flow 47
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1. For our use case, we are using the Get method to find order items by ‘OrderID’.

48 Chapter 10. API Publishing



Data-Services

2. Click OK, and your request object will be configured using the Get method.

10.1. Designing an API Flow 49
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As you can see above, the object has been configured by our requirements.

Note: Under the requestinfo node, additional fields will appear depending on which checkbox is selected in the API
Configuration window.

This concludes the configuration of the REST Request object in Astera Centerprise.

Configuring The REST Response Object

An API endpoint flow begins with a request object and ends at one of the many responses defined as per the flow
execution route.

Note: At least one response object must be configured to complete the API endpoint flow.

1. To start, right-click on the object and select Properties from the context menu.

50 Chapter 10. API Publishing
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Then, the response configuration window will open, where you can specify the HTTP status code to be returned.

10.1. Designing an API Flow 51
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HTTP Status Code: API response will be based on this selection of the HTTP status code and the API flow orchestration
designed. These codes can be designed based on successful runs or errors etc.

To learn more about multiple responses in an API flow, click here.

52 Chapter 10. API Publishing
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Mapped Content Layout: Selecting this option allows you to map a pre-serialized response string and its content type
as input to the response object.

10.1. Designing an API Flow 53
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Custom Layout: Selecting this will allow you to build a layout for the response on the next screen based on the content
type defined.

Content Type: You can select a standard media type for the response payload and define its custom layout on the next
screen. Currently, you can only define custom layouts of JSON type.

54 Chapter 10. API Publishing
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Published Description: This description becomes a part of the auto-generated open API definition.

2. Once done, click Next and you will be taken to the next screen.

10.1. Designing an API Flow 55
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Here, the output layout of the response object can be defined.

On the left side of the screen is the hierarchy of the nodes in your layout. You can add or delete a single instance or
collection members here to create the desired layout.

56 Chapter 10. API Publishing
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The right side of the screen is where the layout is to be added. There are three ways to map the output layout,

• Manually defining objects and fields,

10.1. Designing an API Flow 57
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• Using a sample text.

Selecting this option will open a new window where a sample text, based on the Content-type defined, is given to
generate the layout accordingly.

58 Chapter 10. API Publishing
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Clicking this will open a new sample text window where the text can be pasted.

10.1. Designing an API Flow 59
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Clicking Generate will produce a layout.

60 Chapter 10. API Publishing
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• Generate default layout

Selecting this option will generate a default Centerprise layout which can be used to output an error and any additional
messages.

10.1. Designing an API Flow 61
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As we click on this option, the box is populated.

3. Once done, click Next and you will be led to the Output Parameters screen.

Here, you can define header parameters to be returned as part of the response.

62 Chapter 10. API Publishing
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4. Click Next when done and you will be led to the Pagination screen.

The pagination screen allows you to set a form of pagination on the REST Response data. You can configure Cursor
Pagination for 200 OK responses to retrieve ordered data in small discrete sets, as requested. The first request returns
the records as per Page Size and a cursor field which can then be iteratively used to read the next set of records.

To learn more about pagination, click here.

10.1. Designing an API Flow 63
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Enable Cursor Pagination: Selecting this is going to enable Cursor Pagination on the data payload returned.

Page Size: This determines the size of a page in cursor pagination.

5. Once that has been done, select Next and you will be led to the General Options screen.

64 Chapter 10. API Publishing
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6. Click OK and the REST Response object will be configured. You can now map the fields and parameters from the
flow to the response object.

10.1. Designing an API Flow 65
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Body: This node will show the output layout hierarchy that has been configured within the properties.

Responseinfo: Upon expansion, this node will display additional information that can be mapped to an output to be
processed further in the test-flow, after the API response has been submitted.

Headers: Expanding this node will show any headers that have been defined within the object.

This concludes the REST Response object configuration in Astera API Management.

Using the REST Request and REST Response objects in a flow

Since we have now configured the REST Request and REST Response objects, we can map them together and use them
in a flow. The API flow feeds the input Order ID to a database lookup and returns the output in the response.

The following is a use case built on ‘Order_Details’ data.

66 Chapter 10. API Publishing
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This concludes using the designing of an API flow.

10.2 Request Context Parameters

Request Context Parameters allow us to use Request Parameters anywhere within the scope of the API flow. They can
be used at any point within the flow following the Request object.

For our use case, we will look at the parameters defined in our flow.

1. Right-click on the REST Request object and select Properties from the context menu.

10.2. Request Context Parameters 67
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This will open a new window.
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As you can see in the image above, we have defined a query parameter. This can be directly used as a variable further
in the API flow to design the flow logic and set values.

Following the request object, the flow uses a SQL Query Source object to read all products where the category name
matches the request parameter value. Since a SQL Query Source requires a SQL query to be defined, let’s see how we
can use the incoming query parameter in the context of the SQL query.

These Context Parameters can also be used in other objects as variables. As another example, we have used them to
define expressions.

2. We will open the Properties of the Expression object.

10.2. Request Context Parameters 69
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This will open the configuration window for the object.

3. Click on a field and open the Expression Builder. Here, all request parameters are available and can be referenced
to be used in expression functions.

70 Chapter 10. API Publishing
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Here, you can see that we have defined Request Context Parameters using the values we had in the REST Request object.

10.2. Request Context Parameters 71
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These parameters can be used anywhere ahead in the entire API flow.

This concludes the working of the Request Context Parameters.

10.3 Configuring Sorting and Filtering in API Flows

The Apply Query Parameter object is used to filter and sort data in an API flow in accordance with the user application.
Its location in an API flow can depend on when sorting or filtering is required in the processing of the API request.

72 Chapter 10. API Publishing
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10.3.1 Configuring the Apply Query Parameter object

1. To start, right-click on the object and select Properties from the context menu.

The layout builder window will open.

This is where the layout of the incoming data is going to be mapped. It can be automatically mapped from a preceding
object.

10.3. Configuring Sorting and Filtering in API Flows 73
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Note: The left-side window shows the node hierarchy of the Apply Query Parameter object.

For our use case, we have a flow that fetches order items from the database for the given OrderID in the request. Now,
to allow sorting and filter operations on this response data, we will add the Apply Query Parameter object right after
the Database Lookup object and before the REST Response object.

The position of this object in a flow can depend on where it is required. It can be placed anywhere between objects in
the API flow.

Thus, our layout builder is populated according to our flow.

2. Once done, click Next. Here, you can enable filter and sort functions on the API response data.
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Apply Filter Parameters: This allows users to send filter parameters of response layout fields in the request URL.

Apply Sort Parameters: This allows users to send sort_by parameter of response layout fields in the request URL.

3. Select Ok after you are done with this window and the configuration will be completed.
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The Apply Query Parameter object has been configured to return responses as per the sort or filter parameters requested.

10.3.2 Applying Filter and Sort Parameters in Request

1. To further examine filter and sort functionalities, deploy the flow you have used the Apply Query Parameter object
in.

76 Chapter 10. API Publishing
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2. To deploy the API flow, select the third option from the right, on the designer toolbar

This will open a new screen,

3. Provide the Deployment Name and the Config File Path, if any, and click Ok.

Generate Test Flow for API: Selecting this option will generate a flow to execute a test request for the API in run-time,
to use after deployment.

4. Once done, you can open the generated test flow from the job progress window.
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Note: Since the test flow was generated during the deployment, it already has a REST Connection, and REST Client
auto-populated with the request configuration.

5. Right-click on the REST Client object and select Properties from the context menu.

6. Click Next and you will be led to the Parameters screen.

78 Chapter 10. API Publishing



Data-Services

Here, you can use the sort_by parameter or the filter parameters, with the appropriate syntax, to obtain accurate data.

To sort the response data, we can define the query parameter ‘sort_by’. This parameter takes comma-separated values
for multiple fields that need to be sorted. The syntax for each sort is as follows:

FieldName - SortOrder - Where the sort order can either be asc for ascending or desc for descending.

For example, a sort value as UnitPrice-asc, ProductName-desc would first sort the data by Unit Price in ascending order,
then apply a second sort by Product Name in descending order.

FieldName [Operator] - To add a filter on any of the response fields, you can define a query parameter with this syntax.
The supported operators include,

• Equals to – eq

• Not equal to – neq

• Greater than – gt

• Greater than or equals to – gte

• Less than – lt

• Less than or equals to - lte

For example, to apply a filter on discount, we have defined a query parameter Discount[gt] as the parameter key and
5 as the value for this filter, implying to only show discount records greater than 5 in the response data. Additionally,
more such filter parameters can also be added for other response fields.

Note: This parameter name is defined as a Parameter Key because the name consists of special characters [] which are
not allowed in the Name column. Parameter Key is used instead of Name in the actual API request.

7. Click Ok.
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The parameters have been added.

8. Next, right-click on the REST Client object and select Preview Output to make an API call with the defined param-
eters.

The status code ‘200’ shows that the API call was made successfully.

This concludes the usage of the Apply Query Parameter object after deployment, within an test flow.

10.4 Enable Pagination

You can configure an API flow to paginate response data from the REST Response object.

Pagination is a process that is used to divide large data into smaller discrete pages, thus allowing for less clutter and
better readability. It also means that server request processing will be faster as a small subset is to be returned. Hence,
improving the overall API performance and readability.

For our use case, we have an API flow that is configured to retrieve a collection of order items using a database lookup
along with filter and sort functionalities enabled. Now, let us see how pagination can be configured in this flow.
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1. Right-click on the REST Response object and select Properties from the context menu.
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This will open the Properties window.

82 Chapter 10. API Publishing



Data-Services

2. Click Next until you reach the Response Configuration window.

This is where you can set up pagination options to better structure the response data fetched for a successful 200-OK
request.
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Enable Cursor Pagination: Checking this box lets the incoming data be paginated by a cursor. Cursor-based pagination
works by returning a pointer to the last item in the dataset page, using which the client can make successive requests to
read the next set of records iteratively. Once all records have been read, the cursor value becomes null, thus indicating
that no more records are left to be read.

Page Size: This counter determines the number of records returned in a single requested page.

3. Click OK and the REST Response object will be configured in accordance with the cursor pagination and page size.
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Note: Any request made to this endpoint will return the first n (page size) records along with a ‘cursor’ field in the
response payload. This cursor field can then be reiterated in the next request as a Query Parameter named ‘Cursor’ to
fetch the next n (page size) records.

At runtime, these paginated calls are cached at the server. To learn more about it, click here.

10.5 Asynchronous API Request

In Astera API Management, we can process an API request either synchronously or asynchronously.

In Synchronous execution, the response to the API call does not return until the process has been completed or there
has been an error.

In Asynchronous execution, the response to the API call is returned immediately with a polling URL while the request
continues to be processed.

To check the functionality of such execution, we have created an API flow that will process the request Asynchronously.
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10.5.1 Processing an API Request Asynchronously

For our use case, we are deploying an API flow, which calls another 3rd party API and may take long to respond.

1. To enable Asynchronous execution, right-click on the Request object and select Properties from the context menu.
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This will open the Properties window.
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2. Click Next and you will be led to the API Configuration screen.

By default, the synchronous option has been selected,
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After we select the Asynchronous checkbox, the API controller path in the Example URL also changes to ‘publishin-
gAsync’.
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If we plan to deploy both processing types, the Example URL just shows the Synchronous API example,
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3. Click OK and deploy this flow through the option present in the API flow toolbar.

This will open a new window where the deployment name can be defined.
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4. Once the deployment has been created, you can view it in the Server Browser.

As you can see, the GET endpoint icon here represents Asynchronous processing,

If we had selected both processing types, the endpoints would have looked like this,
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To show each of the steps associated with Asynchronous API requests, we will be using the Postman API Client to
execute a request on the deployed Astera API.

5. Open your Postman Client, create a new collection and add a new request to it.

We have named our first request as ‘PetStore’

6. Select the appropriate method and enter the API URL copied from the API Browser,

We can see the respective Postman request below,

10.5. Asynchronous API Request 93



Data-Services

7. Click on Send.

It shows us that the request was accepted.

We have received a location response header and this parameter contains the successive status API’s URL that can be
used to inspect the API request’s processing status.
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8. Next, send a follow-up request to the status API URL received in the location header.

9. Click Send and you will be able to view the status of the API call in the response body.
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‘Status: Completed’ means that the request we sent was completed.

Apart from this, the other status possibilities are,

Running: The request is still being processed.

Error: The request processing has encountered an error.

Unknown: The request for the given ID was not found or purged.

10. The location response header received with a ‘Completed’ status API call is then used to make the successive API
call to retrieve the API results.
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11. Make a request to this result API to see the actual API response processed.

The result of an Asynchronous request is preserved for a duration of 24 hours after which it is purged/removed.

As you can see, after 24 hours, the status becomes ‘Unknown’ and the Status/Result APIs return a ‘404 Not Found’
response.
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10.5.2 Callback URL

Attaching a Callback URL in an Async request allows the API client to get the response at the server specified in the
URL, rather than polling for a response at various intervals.

The Callback URL’s functionality is implemented for the Asynchronous API Requests. A query parameter called call-
backUrl defining the URL of the listening server is required in the Asynchronous request. Once the request is sent to
the Astera server, it stores this call-back URL and periodically checks for the availability of the response. When the
status is “completed” i.e., when the response is available, the Server sends it to the address that was specified in the
URL.

The visual representation of the process will look like this,

1. Callback URL to the Listening Server,
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2. Callback URL to the Local Host,

Let us consider such a use-case in which a callback URL query parameter with the value “http::” is defined in the
Asynchronous request.

It is necessary to encode the callback URL. After that the request will look something like this,

Once the request is sent, the Astera server checks if the Status of the request is completed or not, and when it is, the
response is sent, and it can be seen at the specified destination address.

Note: We have created a listening server at our end using the JavaScript Code. Its purpose was to continuously send
requests till it receives the status response from the Astera Server and display its headers parameters on the terminal
screen.

Now, the returned Result API’s URL in the Location header parameter can be used to retrieve the response body of the
initial Asynchronous call.

This concludes the article on Asynchronous API Request Execution and Callback URL with respect to Astera API
Management.
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10.6 Multiple Responses Using Conditional Route

An API flow can be conditioned to return a different response as per the designed flow. The server could return a
successful response for a valid request or return a missing parameter response for an incomplete request.

To define an API with multiple responses, we have mapped two REST Response objects through a Route Transformation
object conditioned on the request received. The Route conditions should be defined to take care of routing all the
incoming data to either of the two responses at a time, avoiding any unexpected responses due to race conditions.

Since there is no data flowing for a ‘No Content’ response, such responses can be controlled using Anchor Maps. These
are mapped with the Route Transformation outgoing node for the respective rule.

To create an anchor map, press the icon on the API flow toolbar and create a map from the UnderProcess rule node of
the Route Transformation to the ‘Resp_200_02’ Response object.

This concludes the working of multiple responses in an API flow.

10.7 Workflow Tasks in an API Flow

An API flow orchestration allows the usage of various workflow tasks. These include tasks like Send Mail, System File
Actions, Run Exe Programs, Run Flow tasks, FTP tasks, etc, which can be utilized in accordance with the API action.

Inside the toolbox, the Workflow Tasks tab lists all the available tasks that can be used when designing an API flow.
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For our use case, we have designed an API flow for the ‘Get Product by name’ endpoint.

As you can see in the flow above, two Send Mail workflow tasks have been used. Once a request is received with the
product name, it is sent as an input to the Database Lookup object to fetch a matching record. It is then passed through
a Route Transformation which routes the data to send a confirmation mail for a successful match or a ‘Not Found’ mail
notification otherwise.

The user will either receive a mail that says the item is available or a mail that states that the item is unavailable, and
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the API will return the respective responses.

Note: If no data mappings are available to orchestrate the flow, as in this case when using a Send Mail object, the user
can make use of Anchor Maps to control the flow.

To learn more about how Anchor Maps are used, please refer to the respective document here.

Similarly, here is another way we have used workflow tasks within an API flow,

Instead of using the DB Lookup and Route Transformation object, the entire process has been replaced with a Run
Dataflow object that can run any ETL pipeline.

The dataflow which will be triggered in the API is doing the same work as the previous API flow. However, it is now
less cluttered.

This concludes the functionality of Workflow tasks in an API flow.
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10.8 Enable File Download-Upload Through APIs

Users can utilize APIs to upload and download files to and from the Astera API Management server.

1. Head to the Server Explorer, right-click on the cluster node, and select Server Profiles from the context menu.

This will open a new window.
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2. Create a new profile by clicking on the following icon,
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3. Once the new profile is created, select the Publishing Settings tab,
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4. Go to the API File Server Configuration section. Here, we can configure the file action functionalities.
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Enable File Uploads: Selecting this checkbox will let the user upload files onto the specified server directory.

Enable File Downloads: Selecting this checkbox will let the user download files from the server.

File Expiration Time: This counter determines how long the file will be kept in the Server File Directory before it is
automatically removed.

Server File Directory: This is where the file path will be given to the Server File Directory. All the file uploads will be
saved here, which can also be downloaded.

Note: We can download a file from anywhere on the server as long as that location is accessible by the server using
the Download Path Generator object.

5. Select both checkboxes and provide a file path.

Note: The Server File Directory file path can be at any location that is accessible by the Astera server, be it on local or
remote.
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6. Once done, save the changes to the server profile.
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7. Next, right-click on the Server URL node in the Server Explorer and select Server Properties from the context menu.
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This will open the Server Properties window.
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8. Select the Profile that you have just configured and save it.
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File upload and download functionalities have now been enabled with this profile on the server.

10.8.1 Enable Download-Upload for Non-Admin/Non-Root Users

For a non-admin or a non-root user, we must go to the user roles and enable the Upload Download File APIs option,
otherwise, the user cannot proceed with the upload document.

1. Right-click on a non-root role and select Edit Role Resources from the context menu,
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This will open a new window.
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2. Expand the Url node and select the files node under api to enable download-upload,
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10.8.2 Uploading a File

For our use case, we will be using the Postman API Client from another remote machine.

1. Add a new request to your Postman collection by right-clicking on the collection and selecting Add Request from
the context menu.

2. Select the HTTP method as POST, provide the file API URL deployed at the Astera Server and define a
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multipart/form-date request body,

“HTTPS://ServerHostName:9263/api/files”

Note: ServerHostName is referring to the Server Machine Name for Astera API Management.

3. Define a Key of your choice and select its value type as File,

4. Browse your desired file to the VALUE,

5. Click Send and the file will be uploaded to the specified file directory on the Astera Server.
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As seen from the response above, the respective file has been uploaded.

The FileName is the key defined whereas the path is the relative path of the uploaded file on the Astera Server.

Note: Custom parameters can be defined with the same upload file call as well,

This allows the user to define custom values and overwrite predefined values from Astera API Management. ‘Time-
ToLive’ refers to the time that the file is kept before it expires. ‘AccessPermission’ defines who has access permission
other than the user.
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10.8.3 Downloading a File

1. To download a file from the server, create a new request on Postman.

For our use case, we will be downloading the same file that we previously uploaded to the server.

2. Keep the HTTP method as GET and enter the request URL.

“HTTPS://ServerHostName:9263/api/files/{filepath}”

Note: ServerHostName is referring to the Server Machine Name for Astera API Management.

We are using the same file upload API resource as GET for the download function. However, the difference is that we
provide the relative path of the uploaded file as a resource.

3. For the server to identify the relative file from the request URL, we need to encode the value.
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Note: If we send this request from the Astera API Client, then the object automatically encodes the resource (file path).

4. Click Send and the request will fetch the file’s content in the response body.

5. The response can then be saved to a file using the following option,

This is how a file can be downloaded from the Astera API Management server.

Note: On providing an invalid, wrong, non-encoded, and none-existing file’s file, the request will result in a ‘404 Not
Found’ error with an appropriate message,
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10.8.4 Generating Downloadable path for files through Astera API Management

Astera API Management offers the user the ability to generate the downloadable path for any destination file using the
Download Path Generator object.

This functionality can be seen within the scope of an API flow.

For our use case, we have the following API flow,

In the above flow, we can see that a file path has been given to an API Request object through a Variables object. We
are trying to consume the uploaded file here using its relative path.

The flow then maps the request object to an Excel Source object, used as a transformation, and writes the records to a
Delimited Destination object.

The Delimited Destination object has an additional File node. This enables us to create a new destination file on each
run. Each file is created by appending a unique ID to the destination path given in the object, eliminating the chances
of overwriting an existing file. This FilePath field outputs the unique path generated at runtime.

This can be enabled for any destination object.

1. Right-click on the Delimited Destination and select Properties. Next, check the Create new file on each run option.
This will add the unique file path node to the destination object.
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2. Drag and drop a Download Path Generator object from the toolbox onto the API flow.

In order for us to obtain a downloadable path for our file, we require the use of this object.
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3. Map the input using the File Path field from the Delimited Destination object and map the output towards the API
Response object.

This downloadable file path can now be used in further applications where the file is required.

Note: The Download Path Generator object cannot be previewed at design time because the downloadable path is
generated at run-time.

Below, we can see the request being sent from Postman and the user receiving the downloadable path in the response.

This concludes our document on enabling and using file download/upload in Astera API Management.
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10.9 Database CRUD APIs Auto-Generation

Users can auto-generate CRUD API endpoints for any database using the Data Source Browser. CRUD APIs are meant
for Create-Retrieve-Update-Delete operations on the database table records.

1. Click on View in the main menu bar and select Data Source Browser from the drop-down menu.
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This will open the Data Source Browser.
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2. Add a new database server by selecting the Add Database Server option.

This will open a configuration window to define a database connection. A database server can be configured from any
of the listed providers.
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3. Add all the essential details to configure the database server connection and click OK.
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Now, the Data Source Browser will be populated with all the databases from the connected server.
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4. Right-click on any database and select Generate CRUD flows from the context menu.

Note: It is necessary for a project to be open when CRUD API flows are generated, since they are added under a CRUD
folder created in the project.
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This will open a new window.

Here, you can select the tables and the respective CRUD operations to generate API flows.
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For our use case, we will be selecting the Orders table. The following operations are available for each table:

1. Find all records – A Get method that fetches all the records

2. Get record by ID – A Get method along with a path parameter for a key that fetches the records based on the key.

3. Create a new record – Selecting this creates a new record.

4. Update a record by ID – Selecting this option lets the user update a record by ID

5. Delete a record by ID – Selecting this option lets the user delete a record by ID.
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The user can even select configurations inside each endpoint, whether they want to enable sort or filter, or whether their
execution type is Synchronous or Asynchronous.

5. Once done, click Generate and the CRUD flows will be generated.

You can then view the API endpoints in the Project Explorer.
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6. Now, you can directly group and deploy with a single click,
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or open any of the API flows to see pre-configured API flows or make any changes.
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This concludes the working of the Database APIs CRUD auto-generation in Astera Centerprise.

10.10 Pre-deployment Testing and Verification of API flows

10.10.1 Instant Data Preview

When designing an API flow, users can benefit from the functionality to instantly preview and verify the input and
output data for any action in the flow. Carrying out data-driven testing of the API functionality at design time helps
identify any possible hindrances sooner.

To define test values for the API flow, the Request object must be set as a transformation and any test data can be
mapped to it. Right-click on the Request object and select Transformation.
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Since the request object is a Singleton object, only the first record is processed through the flow. This behavior compli-
ments the runtime behavior of a single API call and provides ease in previewing the respective results. Let’s preview
the Request object to observe this.

10.10.2 Raw Request/Response Preview

The Preview Raw option alternatively allows the users to view the API request and response in a raw unformatted form.
This option is useful as it not only displays the data as a raw HTTPS packet but also gives us the benefit of copying,
saving, or sharing the JSON body of both the request and response.

Let’s take an example API flow and see how we can preview the raw request in Centerprise,

This API flow uses the GET HTTPS Method and allows the API user to view the Customers table’s records based
on the value of the URI parameter username. For demonstration, Header parameters i.e., Accept, UserAgent, Query
parameter i.e., cursor, and RequestInfo parameters i.e., HTTPMethod, Content-Type are also defined.
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1. The Raw Data Preview window will automatically open when a raw request/response is previewed. However, we
can manually open the window as well. To do that, go to the Menu bar > View > Raw Data Preview or use the shortcut
Ctrl+Alt+J.
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2. Right-click on the header of the Request Publish object. Select the Preview Raw Request option from the context
menu.

Note: Preview would only work when Request has some incoming data mapped to it.
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In a raw API Request, you can see:

• URL: Contains the HTTPS Method, Resource, URI, and Query parameters.Host: The server on which the API
is deployed.

• RequestInfo: Default parameters containing information related to the server and request.
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• Header: User-defined parameters containing meta-data associated with the request.

• Body: In case of a request other than GET, an input JSON body.

This is how a complete request looks in the Raw Data Preview window,

The RequestInfo, Parameters, and JSON Body are displayed in separate tabs.

In case of a request other than GET, we’ll be able to see the Input JSON Body in the Body tab. Similar to this:
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In a raw API response, you can see:

• Date: It specifies the date and time at which the client receives the response.

• HTTPS Status Code: It defines the standard response status expected from the executed flow i.e., 200 for OK or
400 Bad Request, etc.

• HTTPS Status Description: The standard response description matching the HTTPS Status code i.e., OK for a
200 code or BAD REQUEST for a 400 code, etc.

• Header Parameters: User-defined parameters containing meta-data associated with the response.

• Content: It contains the whole response body content in a string-like text.

• Content-Type: It describes the format type of the response body content.

• Content-Length: It specifies the number of bytes in the content of the response body.

• Body: It shows the response content parsed as per a defined Custom Response Layout.

Let’s see how we can preview the raw response in Centerprise,

1. Right-click on the header of the Response Publish object. Select the Preview Raw Response option from the context
menu.
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This is how the whole response looks in the Raw Data Preview,
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Similarly, the RequestInfo, Header Parameters, and JSON Body are displayed in separate tabs.

10.10.3 Save/Copy JSON

Using the Preview Raw Response/Response option, it is also possible to copy and save the JSON body of both the
request and response.

1. Click on the Copy JSON Body icon in the Raw Data Preview window.
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2. Similarly, click on the Save JSON Body icon to save the JSON body at the desired destination in a JSON format file.
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Enter the desired destination in the Save JSON Body window and click Save to store the file.
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This is what the save JSON file looks like,

146 Chapter 10. API Publishing



Data-Services

10.10.4 Flow Verification

If the API flow contains any errors or warnings that affect the flow of data, they are displayed in the Raw/Data Preview
window. In other words, if any obstacles block the flow of data from the Request to Response, the error is shown
prominently on the window.

For example, we can see that the flow of data has been broken between the Request and Database Source object,
resulting in an error state i.e., the Route is unable to identify a parameter, and as we preview the object we can see the
error message in the window.

As for the whole API flow’s verification, it is advised to use the Verify Pushdown Job option. To learn more about
pushdown verification in API flows, click here.

This concludes our discussion on pre-deployment testing and verification of API flows.

10.11 API Deployment

Using Astera API Management, users can design a complete set of API (Application Programming Interface) endpoint
flows in a drag-and-drop interface. These APIs can then be deployed to the Astera Server before they can be consumed.

In this document, we will learn how to deploy API flows on the Astera Server. API flows can be deployed individually
or as a group set in folder hierarchies.
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10.11.1 Deploying a single API Flow

Here, we have a pre-designed API flow,

Let’s see how we can deploy this.

1. Click the Deploy API Flow icon on the API flow toolbar.

Similarly, the Deploy API Flow option from the Project Explorer context menu can also be used. This option is only
available for API flows.
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The Deployment window will appear like this,
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• Method: It’s the HTTPS method selected in the Request object in the API flow.

• Resource: The endpoint defined in the Request object.

• Deployment Name: The name used to refer to this deployment in the Server Browser.

• Example URL: The complete URL that will be used to make the request. It includes the Base URL, Resource,
URI, and Query parameters.

• Config File Path: The path of an optional deployment config file to define runtime variables used in the API
flows.

• Generate Test Flow for API: Its functionality detail is given here.

2. Define the Deployment Name and the Config File Path (optional). Click OK.
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The API Flow is verified in pushdown mode before the creation of the deployment. In case of any verification errors,
the deployment will not be created, and the success or failure of deployment status will appear in the Job Progress
window. In this case, as you can see, the deployment is completed successfully.

Once the deployment is successfully created, it becomes available in the Server Browser.

This is how you can deploy an API flow. Now, let’s see how we can group and deploy API flows at the folder level.
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10.11.2 Group and Deploy APIs

We can group and deploy API flow(s) contained under a folder. All the folder nodes present under the project have the
Group and Deploy All API Flows under this Folder option, including the parent .cprj project node. Only the API flows
shall be verified and deployed whereas all the other artifacts will not be considered in the deployment process.

1. Right-click on the desired folder and select Group and Deploy All API Flows under this Folder option.

Note: It is recommended to first verify all flows in pushdown and resolve any errors before proceeding to deployment.
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In this example, we have grouped and deployed all API flows under the folder called “Data”. It’s notice-
able that the folder, “Data”, has a nested folder, “v1”, under it. In the case of deploying from a folder
that contains nested/child folder(s), the name of the nested folder(s) will be appended to the API’s URL as
a part of its Resource. For example, ‘’{base URL}/Nested Folder Name/Flow Resource/Parameters” such as
‘’https://localhost:9621/v1/{Resource}/{Parameters}.”

Similarly, we can see a “Dataflow1.Df” artifact under the folder as well. As explained before, this dataflow will not be
considered during the deployment process.

Note: Please note that during group and deploy, the parent folder’s name is not considered as part of the resource.

After selecting the option, the Deployment window will appear like this,

2. Write the Deployment Name and set the path of the Config File (optional). Click OK.

Note: All API Flows are verified in Pushdown mode before the deployment is created.

Success or Failure of the deployment will appear in the Job Progress window. In case of any errors, the verification
window can be used to identify and fix errors. As the verification was successful, the API endpoints are visible in the
trace.
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The successfully created deployment is visible in the Server Browser.

Note: Notice endpoint annotated in yellow. We can see here the nested folder name has been appended as a resource.

This is how you can group deploy the API(s) at the folder level.

10.11. API Deployment 155



Data-Services

10.12 Test Flow Generation

10.12.1 Generating a Test Flow

The Generate Test Flow option auto creates post-deployment test flows. These dataflows can be used to make live
requests to the deployed API endpoints using the REST Client and REST Connection objects.

The REST Connection object contains the base URL of the server where the APIs are deployed and is configured with
an Access Token for Authentication.

The REST Client object encapsulates the entire API flow’s logic, starting from the Request object to the Response
Publish object, including request parameters, request and response content bodies, and pagination configurations.

Other objects that are mapped either to the Request object or from the Response object will not be encapsulated in the
API deployment and shall remain as it is in the test flow generated.

However, any Workflow Tasks shall not be made part of the testflow.

Flow Level

Generate Test Flow Icon

At the flow level, use the Generate Test Flow icon in the API flow toolbar to create the test flow for a deployed API.

Check the Job Progress to see if the test case generation resulted in a failure or success. Here, it is successful. This is
the generated test flow for the API.

156 Chapter 10. API Publishing



Data-Services

You can run this test dataflow to check the behavior and assess the performance and functionality of the designed API.

Generate Test Flow for API checkbox

At the flow level, we can also check the Generate Test Flow for API checkbox on the deployment window.

This creates the test flow after the creation of the deployment. However, only when the API flow’s verification is
successful, the test flow is created. Otherwise, the entire process results in an error.
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Folder Level

Generate Test Flows for grouped APIs checkbox

For the Folder level test flow generation, check the Generate Test Flows for Grouped APIs check box while deploying
the APIs.

Check the Job Progress to see if the verification of the API flows and the test case generation resulted in a failure or
success along with the deployment creation job traces. Here, the test flow creation was successful.

10.12.2 Verification of the API Flows

The initial process before the creation of deployment is the verification of the API Flow(s). By default, the deployment
is verified in pushdown mode. If the flows are not pushdown-able, they are verified in the non-pushdown mode. To
learn about pushdown mode, click here.

If the API deployment contains any errors or warnings, the deployment process is terminated with a link provided in
the Job Progress window.
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Clicking on this View Verification Logs link opens the Verify window. Here, we can see the verification logs. Its shows
the Severity i.e., Error or Warning, the Name of the object which contains the issue, and the Message which is the
description of the error/warning.

Please note that the verification process for both the Flow level and Group Level deployment is the same.

This concludes our discussion on Test flow Generation.

10.13 Server Browser Functionalities for API Publishing

The Server Browser in Astera API Management can be used to see all the Deployments/APIs/API services that the user
has deployed onto the Astera Integration Server.
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10.13.1 REST API Deployment View

Once we have deployed our API flows, we can see the deployment in the Server Browser,

We can select a different view if we click on the Select Deployment View - Filter option (the filter icon on the left) in
the Server Browser toolbar.

Let us select REST API Deployments from the drop-down menu.
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This will open a new view for the user. Here, you can directly see the deployments that have been made by the user(s).
If we expand a deployment, we can see all the available endpoints under it.
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When we deploy the API flow, a description is automatically added, for each endpoint/API flow. This is with respect
to the action performed by the API flow.
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Note: We can see two entries for each endpoint because each endpoint can be processed Synchronously and Asyn-
chronously.

Synchronously processed endpoints can be seen with the HTTP method on its own and Asynchronously processed
endpoints can be seen with the HTTP method encircled with blue curves.
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10.13.2 Active Endpoint View

We can see a consolidated view containing only the active endpoints from each deployment using the following option.

This will show the user a different view,
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We can see the endpoints in a tree-like or hierarchical structure. Each endpoint is characterized based on its resource.

Upon hovering over each endpoint, their Request URL can be seen,
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10.13.3 Context Options

Deployment Context Options

If we move back to the REST API Deployment View, we can see some options in the context menu of each of the
deployments.
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View Deployment: Selecting this option will let the user view the deployment in the deployment manager.
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Export as OpenAPI file: Selecting this option will allow the user to generate an Open API specification JSON file
which we can export/save to the desired location, be it local or on a network.

This file can be used to import the API collection to any third-party tool i.e., Postman, Insomnia, etc., for consumption.

Copy Swagger URL: This option lets the user copy the Swagger URL for the deployment. We can use this URL to
generate the swagger definition file for the API collection.
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Remove Deployment: Selecting this option will remove the selected deployment from the Server Browser.

Endpoint Context Options

Each deployment can either have a single endpoint or multiple ones. Similar to deployment, a context menu is available
for each endpoint as well.
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Copy URL to Clipboard: This option allows the user to copy the endpoint’s request URL to the clipboard.

Show Runtime Trace: Selecting this option will show the runtime trace for that endpoint.

Deactivate: Selecting this option will deactivate a particular endpoint.

Note: Select the Activate option to re-activate the service.

No Authentication Required: Selecting this option will disable the authentication required by this endpoint. To enable
the authentication, open the context menu again and select the Authentication Required option.
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10.13.4 Security

In terms of security, Astera Centerprise gives the user the ability to define roles and provide resources to each role.

The security view in the Server Browser can be selected from the Server Browser drop-down menu,

This will open a new view,

Expanding the User and Roles nodes shows us the centerprise client’s users and the available roles respectively.
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Note:

• New users can be added by right-clicking on the User option and selecting Register User from the context menu.

• New roles can be added by right-clicking on the Roles option and selecting Add New Role from the context menu.

Resources of each role can be allocated by right-clicking on the role and selecting Edit Role Resources from the context
menu.

Here, the resources available below are,

• URL

• Cmd

• REST – Publishing and Publishing Async

Note: A user needs to have the REST API resources enabled for the deployed API to avail the API services. Otherwise,
they might never be able to use the deployed APIs.
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Note: Users will only be able to access the resources that have been allocated to their role.

To assign a role to a user, right-click on the user and select Edit User Roles from the context menu.

Note: Selecting the specific role and then clicking the right-facing arrow will assign the role to the user. Clicking the
left-facing arrow after checking a role will remove the role from the user.
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10.13.5 Additional Server Browser Options

Apart from the deployment view options, these are the following options also present on the main menu bar of the
Server Browser.

Add Deployment: Adds a new deployment

Remove All Deployments: Removes all deployments present on the Server Browser

Expand All: Expands each of the nodes of all the deployments.

Search Bar: Here, you can write a name to search for any specific deployment or an endpoint.

This concludes the Server Browser functionalities for API Publishing in Astera Centerprise.

10.14 API Monitoring

Astera API Management lets users monitor live metrics for all deployed APIs using a Visualization Dashboard.

Select the Plots Explorer view in the Server Browser.

This will open a new view.
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Right-click on the option present underneath the Dashboard node and select Open Dashboard from the context menu.

Selecting this will open the dashboard window.
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The dashboard shows various performance metrics and graphs which can be used to monitor the deployed APIs. These
include,

Total number of requests

Requests per second - Measures the throughput of the API server, gauging the number of requests the server can handle
in a time unit of a second.

Average response duration - This is a critical KPI that signifies the average time taken for an API to respond.

Most Recent Logs Record - Lists the 10 most recent requests catered along with detailed information about the server
and client.

Requests by Response Status - This shows the percentage of each of the different responses for the deployed APIs.

Requests by Timespan - A bar graph that highlights the traffic received as per the number of requests received with
time.

Average Response Duration by Timespan - A line graph showing the average response durations with time.

Using the Data Range filter, all these metrics and graphs can also be filtered by a data view.
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Note: The source table for the dashboard can be configured to purge.

From the Server Explorer, right-click on the cluster node and open Cluster Settings. Here, you can set the Purge REST
Request Info After value to enable purging the source table.

A value of 0 signifies that the table would never be purged.

This concludes API Monitoring in Astera API Management.
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10.15 Logging and Tracing

In Astera API Management, users can troubleshoot runtime issues by monitoring live tracing for any APIs deployed
on the server.

To configure logging, create a new server profile by right-clicking on the cluster node in the Server Explorer and
selecting Server Profiles from the context menu.

This will open a new window.

1. Create a new profile by selecting the Add a new server profile option.
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As you can see, we already have a server profile created.

2. Select the Publishing Settings tab and scroll down to the API Runtime logging and tracing section.
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Here, the user can select the level of logs to be traced, including information, warnings, errors, or all-inclusive. The
logging stages include,

Request Validator Logs: It includes pre-validating the request context before sending it through the runtime processor
by validating the server availability, and deployment activity, and inspecting if the request has the supported formats.

Processor Logs: Processor logs include runtime components of the request, including information about a cached
request pipeline, the concurrent pipelines in execution, and runtime capacity.

180 Chapter 10. API Publishing



Data-Services

Purge Event Logs After: This counter shows the number of days after which the logs will be purged/removed since a
lot of them can accumulate at runtime.

Once the server profile is configured and saved, the next step is to select this profile in the Server Properties.

After logging and tracing have been configured, users can now view the live runtime traces generated for all deployed
APIs.

Next, go to the Server Browser and open the Deployed Endpoint View. To view the tracing for any deployed API,
right-click and select Show Runtime Trace for any API deployment listed.

You can now see the trace.
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This concludes logging and tracing in Astera API Management.
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ELEVEN

API CONSUMPTION

11.1 API Connection

To make an API call, an API Connection object needs to be configured first. This object stores all the common infor-
mation that can be shared across multiple API requests.

11.1.1 Configuring The API Connection Object

1. Drag-and-drop the API Connection object from the Toolbox onto a dataflow.

Note: It can also be stored as a shared action file.

2. Right-click on the API Connection object and select Properties from the context menu.

183



Data-Services

A configuration window will appear on your screen.

Base URL: Here, you can specify the base URL of the API which will prepend as a common path to all API endpoints
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sharing this connection. A Base URL usually consists of the scheme, hostname, and port of the API web address.

Note: When a user imports an API definition, a shared connection file containing the Base URL and authentication
type is automatically created within the project. To learn more about importing APIs in Astera Centerprise, click here.

Timeout (msec): Specify the duration, in milliseconds, to wait for the API server to respond before giving a timeout
error.

Include Client SSL Certificate: Check this box to include an imported client certificate for the specified base URL. To
learn more about importing SSL certificates, click here.

Enable Authentication Logs: Select this checkbox to enable authentication logging for APIs.

Authentication – Security Type: Specify the authentication type for the API.

Astera supports the following authentication types

Types Of Authentications:

Identification and verification of a user is an important aspect of authentication. Authentication allows an application
to determine whether a user identity is valid/authorized; based on the outcome, a user is provided access control to the
application.

For APIs, authentication plays a key role in authorizing requests to the API platform’s resources. The following au-
thentication types are available within the API Connection object.

1. No Authentication

2. OAuth 2

3. API Key

4. Basic Authentication

5. Bearer Token
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6. AWS Signature

7. NTLM

No Authentication

With this security type, the user can send API requests without including any authentication parameters.

OAuth 2

This type is used when an unrelated application login is used to acquire permission to access data on your behalf for
another application. Instead of giving away your password to the application, OAuth 2 enables delegated authorization
through a third-party Authorization Server.

In response to a valid authorization, the Auth Server issues an Access Token with a restricted scope and validity to
authenticate the user with permissions. When the Access Token expires, its Refresh Token is used to obtain another
valid Access Token.

Configure an OAuth 2 request to generate Access and Refresh tokens. The tokens will be implicitly added to the request
and auto-refreshed if expired.

186 Chapter 11. API Consumption



Data-Services

The OAuth 2 authentication supports different flows for various scenarios. You can select any of the following Grant
Types:

1. Implicit

2. Authorization Code

3. Authorization Code (with PKCE)

4. Password

5. Client Credentials

Implicit

In this Grant Type, you only need to provide an Authentication URL and Client ID to request a token without an
intermediate code exchange. It was built for apps such as native Java script clients, and mobile or browser-based
applications where client secrets cannot be exposed.

Hence, this flow promptly gets the token directly exposed in the URL and is considered less secure for web applications.
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Authentication URL: This is the login page, where the API user authorizes itself to the Authentication Server.

Client ID: This is the public identifier for accessing the registered API Server application.

Authorization Code

This flow type is popular for mobile and web server-side applications.

In this Grant Type, you need to provide an Authentication URL, Access Token URL, Client ID, and, optionally, a Client
Secret to authorize.

The flow first requests a one-time authorization code from the authorization server. The authorized request is redirected
to the API Server along with its client secret which then authenticates the user for its resources by exchanging the code
for an Access Token.
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Authentication URL: This is the login page, where the API user authorizes itself to the Auth Server.

Access Token URL: This URL is provided to generate an Access Token for authentication after the user has been
authorized successfully.

Client ID: The public identifier for accessing the registered API Server application.

Client Secret: It is provided alongside the Client ID, as a secret credential to access the registered application from the
Auth Server.

After providing the authentication details, click on the Request Token option to sign in and fetch the token(s).

Authorization Code with PKCE

The Proof Key for Code Exchange flow has replaced implicit authentication flow by being more secure to be used in
single-page native, mobile, and browser-based apps. As such apps existing on the browser cannot store client secrets,
this Authorization Code flow keeps the client secret hidden.

Instead, the client sends a dynamically generated string generated using a code_verifier hashed to a code_challange to
the Auth Server. The Auth Server stores this for verifying the client during the OAuth2 exchange.

The Client app then makes an authorization request and receives the Auth Code as a result. It then requests an Access
Token by sending the Auth Code together with the code_verifier that is hashed by the Authorization server and compared
to its saved copy for verification.

In this Grant Type, you need to provide an Authentication URL, Access Token URL, and the Client ID to authorize.
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Password

In this Grant Type, you need an Access Token URL, Username, Password, Client ID, and Client Secret to authorize.
It is considered for internal services and not recommended for third-party applications as it authenticates the given
credentials in a single step.

Since user credentials are exposed to the client application, this flow type outlaws the OAuth2 principles and is now
deprecated.

Access Token URL: The URL through which the Access token is going to be generated for authentication.

Username: The application login name of the user for authentication.

Password: The application user password is provided for authentication.
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Client ID: The public identifier for accessing the registered API Server Application.

Client Secret: It is provided alongside the Client ID, as a secret credential to access the registered application from the
Auth Server.

After providing the authentication details, click on Request Token to fetch the token(s).

Client Credentials

In this Grant Type, you need the Access Token URL, Client ID, and Client Secret to authorize. This is used with the
client application. It self-authenticates access to its resources without a user context.

Access Token URL: This URL is provided to generate an access token for authentication.

Client ID: The public identifier for accessing the registered API Server application.

Client Secret: It is provided alongside the Client ID, as a secret credential to access the registered application from the
Auth Server.

After providing the authentication details, click on Reqeust Token to fetch the token(s).

Additional OAuth 2 Info

An OAuth 2 authentication flow requires some additional parameters to specify resources and scope permissions asso-
ciated with the given Access Token.

To provide additional information required by an API provider for an OAuth2 request, click on the Additional Info
button.
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Resource: Use this to identify the URL of the web API intended for user access.

Scope: Use this to specify what the authenticating application can do on behalf of a user by imposing a limit on which
resources it can access and with what rights.

State: This parameter is useful to protect against XSRF as the client generates and sends a random string while the
Auth Server returns it back again on authenticating as a verification.

Response Type: This parameter is used to specify the expected type to be received from the authorization server on
valid authorization. The most common inputs are “code” and “token”. Code is used for the Authorization Code grant
type where it is exchanged in the follow-up request for the token. A token is used for implicit grant type where the
Access Token is returned directly.
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Callback URL: Redirected URL after the authentication request at which the token/code will be returned. For Astera
Centerprise, use “http://localhost:8050/” or “https://localhost:8050/”

Include SSL Certificate: To include the client certificate in the OAuth2 token generation request.

Ignore Certificate Errors: Check to ignore any certificate errors while authenticating.

Additional Parameters: Any additional parameters apart from the above list that are required to be sent in the authen-
tication request can be added here as key-value pairs, separated by a comma.

Token Caching and Auto-Refresh

Following the security policy of authenticating an API call, clients are required to obtain Access/Refresh tokens for
authenticating an API request. These tokens may have a defined validity and need to be invoked again to generate a
new token.

Once authentication details are fully configured, users need to manually ‘Request Token’ in the API Connection.

Handling token expiry and Automation

For the OAuth2 grant flow which requires users to authenticate when requesting a token, the refresh token can be used to
obtain a new access token. While other grant flows directly make the call to request an access token, Astera Centerprise
can automatically obtain a new token in the background so your flows can be automated.

You can make use of the auto-generation and caching of these tokens which enables you to automate API requests
ensuring new tokens are generated for use without needing to manually update the tokens each time.
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Using ‘Client Credentials’ or ‘Password’ OAuth2 Grant Types

These grant flows work by making a single call requesting an Access Token along with the provided client application
credentials. Since the flow is not dependent on any user input for authentication, it can be automated for the regeneration
of a new token when the existing token expires.

Here, I have a pre-configured authentication with an expired token. Let’s see what happens when this flow is executed
with an expired token.

The job trace shows that an expired token was found, and a new token has been generated for this connection and saved
to the server cache for future reuse.

On the next run, the server is bound to check the cache for a valid token before opting to generate a new one. The cache
stores a token for each unique connection used across all jobs running on the server.
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Use of a Refresh Token

For other OAuth2 grant flows that require the user to authenticate first, the refresh token is used to regenerate the access
token automatically.

Using Default User Browser for User Authentication

Some API Providers restrict using an embedded browser for authenticating using the OAuth2 code exchange. An
alternate option is to request token through a more secure browser-based OAuth authentication.

In this article, we’ll discuss how to run an OAuth2.0 flow for Google Calendar API using the user’s default browser.
Users will first need to create an oauth2 application on the Google Developers’ account and obtain the client id and
secret.

Authenticating the Client Application

For this example, we will be authenticating Google APIs which do not allow the use of an Embedded Browser for an
OAuth2 exchange.

1. Open the API Connection to configure authentication information.

As Google Calendar API works with OAuth2.0 security with Authorization Code grant type, we can select and configure
it accordingly.

11.1. API Connection 195



Data-Services

We must enter parameters such as Authentication URL, Access Token URL, Client ID, Client Secret, and Additional
Information according to the authentication and authorization information provided by Google. Now, let’s click on the
Request Token button to generate the access and refresh tokens.

This opens the Embedded Browser of the Astera Client which will result in an error as Google does not allow authen-
tication via an embedded browser. For such platforms, it is necessary to use a more secure user-default browser for
OAuth2 authentication exchange.

Close the embedded browser window. Now, check the option to Use System’s Default Browser and click on the Request
Token button again.

This opens the user system’s default browser for authentication, and this allows us to successfully retrieve the access
token on logging in. In our case, the default Microsoft Edge web browser has opened.
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Note: Whether the embedded or secure browsers are allowed for authentication strictly depends upon the API provider.

Click on Continue.

The generated Access Token along with the Refresh Token (if supported by the API provider) are displayed on the
REST Connection window with their respective expiry date and time.
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Tested System Browsers

The following browsers have been successfully tested for the Astera Client,

• Google Chrome

• Microsoft Edge

• Firebox

API Key

An API Key is a key-value pair that a client provides when it makes an API request. They can be sent in the Query
string or as a request Header.

It requires two parameters for authentication:

1. Key

2. Value
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API Key as a Query

API Key as a Header

Note: API Key is sent in as a key-value pair in the header such as “apikey: cZRcTZt7R3gnTt9l2C9YHXke0SNDAPJK”

11.1. API Connection 199



Data-Services

Basic Authentication

Basic Authentication is structured according to the HTTP protocol to provide a Username and Password when making
an API request.

In basic HTTP authentication, a request header parameter is included in the form of “Authentication: Basic”, where
the encoded string is the Base64 encoded.

Bearer Token

Bearer Token is an HTTP-based authentication. The access token generated by the server in response to a login request
is in turn included in the request header.

To generate a Bearer Token, you need:

1. User Name

2. Password

3. Token URL
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Note: This Authentication type is needed to access Astera APIs, and the request is sent as “application/JSON”.

SSL Certificate Authentication

API clients can enable the use of a private signed certificate to authenticate themselves when accessing APIs through
mutual TLS. You can configure APIs to use a .pem or a .pkt certificate paired with a certificate key or password.

A Client certificate contains information used to identify the client including a digital signature and it is imported for
a specific domain. All HTTPS - SSL-enabled requests matching the domain URL will authenticate using the installed
client certificate.

All certificates used in authenticating API requests from the client will be imported to Astera’s Server and are included
as authentication when an API request is sent. To import a client certificate for authenticating API requests,

1. Navigate to the Server tab on the main menu bar.

2. Right-click on the cluster node and select Client Certificates.
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This opens the wizard to manage client SSL certificates.

3. Click on the import icon at the top left to add a certificate authenticating to a domain.

Importing a .pem certificate

• Define the requested domain which will include this certificate.

• Browse the .pem client certificate file obtained as a counterpart to the authenticating server certificate present on
the API provider.

• Provide the matching key file for the given client certificate.

Click import.

Now this certificate can be used with SSL-enabled authentication for API requests sent to the given domain.
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Importing a .pfx certificate

• Define the requested domain which will include this certificate.

• Browser the .pfx client certificate file obtained as a counterpart to the authenticating server certificate present on
the API provider.

• Enter the password for the certificate.

Click Import.

Now this certificate can be used with SSL-enabled authentication for API requests sent to the given domain.

Enabling SSL Certificate Authentication

Once the certificate has been imported for the respective domain, let’s see how to make an API request with SSL
enabled.

You need to enable SSL verification to include the certificate when making an API call. To enable SSL, open the API
Connection object which has the Base URL domain, and the authentication configured. To include the SSL certificate,
check the option to “Include Client SSL Certificate”.

Click Ok and preview the API Client to send a request.

This request now includes the certificate to validate the client on the mutual TLS authentication.
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Note: To include the client certificate in the Oauth2 request from the API Connection, check this option from Additional
Info.
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Shared Parameters

This is where you can define query or header parameters to be shared across all clients using the same connection.
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Name: The name of a Query or Header parameter can be defined here.

Parameter Location: This option defines whether the parameter has a Query location or a Header location.
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Data Type: This option defines the data type of the parameter from a list of options.

The parameter values defined here will be inherited by all API clients using this connection unless overridden individ-
ually.

4. Once done, click Next and you will be led to the Config Parameters screen.

Here, config parameter values can be changed according to your application. Parameters not changed will use their
default values.

5. Click Next, and you will be led to the General Options screen.
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Here, you can add any Comments that you wish to add. The rest of the options for this object have been disabled.

6. Click OK to close the window.

You have successfully configured the API Connection object.
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11.1.2 Using the API Connection Object

In a Dataflow

1. Click on File in the main toolbar, hover over New, and select Dataflow from the drop-down menu.

2. Once the dataflow is open, drag-and-drop the API Connection and API Client objects from the Toolbox onto the
dataflow.

Note: The API Connection here can only be accessed within the scope of this dataflow.

3. Configure the API Connection object for the Base URL, Authentication.

Right-click on the API Client object and select Properties from the context menu.
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A new API Client Properties window will open.
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The Shared Connection dropdown list shows us the API Connection object present in the same dataflow.
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You can now use this API Client object to make API calls within Astera API Management.

In a Project

1. Navigate to the main toolbar, click Project, hover over New, and select a project type. Please click here for more
information on creating projects.

Note: You can also open a previously existing project.
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2. Locate the Project Explorer on the right, right-click on the project or one of its folders and select Add New Item from
the context menu.
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This will open a new window where a new SharedAction can be added to the project.

3. Within the SharedAction file, drag-and-drop the API Connection object from the Toolbox.

Note: The SharedAction file should only contain a single API Connection object.

4. Configure the API Connection object with Base URL, Authentication, and Shared Parameters and save the SharedAc-
tion file

This API Connection can be used in any flow document contained in the same project.

5. Next, open a new dataflow within the project.
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6. Drag-and-drop the API Client object onto the dataflow, right-click on it, and select Properties from the context
menu.

A new window will open.

Here, you can see the name of the Shared Connection within the drop-down menu of the Properties option.

Note: Within the project, the shared API Connection can be accessed within any flow.

• If shared connections with duplicate names exist in the project, only one will be shown and used.
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• If duplicate connections exist in the flow and the project, the flow connection will be given preference.

This concludes our discussion on the configuration and use of the API Connection object in Astera API Management.

11.2 Making API Calls with the API Client Object in Astera API Man-
agement

To make an API call in Astera API Management, an API Client object, along with its API Connection, needs to be
configured.

First, drag and drop an API Connection object from the Toolbox and configure it in the dataflow. Alternatively, you can
use an API Connection object in a shared action file within the scope of the project you are working with.

The API Connection object contains the Base URL, authentication details, and shared parameters for the API endpoint.

You can learn all about the configuration and usage of the API Connection object here.

Next, let’s configure the API Client object.

1. First, drag and drop an API Client object from the Toolbox onto the dataflow.

2. Right-click on the API Client object’s header and select Properties.
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The API Client screen will now open. Here you will have to specify the following,
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Shared Connection: Establish your API Client’s connection from this drop-down that lists all shared connections from
within the flow as well as from the project.

HTTP Method: The HTTP request verb defines the operation you want to make on the API resource.

Resource: the resource of the API from which you want to make a request. This will be appended after the Base URL
from the selected shared connection to form the complete endpoint. Any URI or path parameters must be included in
the resource text enclosed in curly brackets, {}.

Input Content Type: This is the content-type header for the request payload which is default to application/JSON type.
The actual request payload layout can be defined in the input layout screen.

Output Content Type: This is the content type of the response payload which is default to application/JSON type. The
actual response payload layout can be defined in the output layout screen.

Note: For an unsupported type, a relevant pop-up notification will appear on-screen.

3. Click Next. A Parameters screen will appear.

Here you will have to specify the following,
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Override Inherited Parameter: Check this to override any parameters previously defined and inherited from the shared
connection.

Name: The name of your parameter.

Parameter Key: Since the Name column does not allow any special characters, the parameter key can be used to define
an alternate name including any special characters to replace the name in the API request.

Parameter Location: The parameter type such as Query, URI, and Header.

Data Type: Specify the data type of your parameter.

Format: Define the datatype format of the parameter’s value sent in the API request.

Plaintext: Check this box to disable URL encoding the parameters when the request is sent. The parameters will be
sent in plaintext format, or you could optionally encode your parameter values manually using the URLEncode function
from the toolbox.

Default Value: The parameter’s value for which you want to make a request.

Note: Any values mapped to the input node of the object will take preference.

4. Click Next. An API Client Output Layout screen will now open.

Here, we will select the Generate Layout by Running Request to build the response layout. Alternatively, you can build
the layout manually or use a sample text.

Next, click OK.
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Note: Prior to this screen, there will be an additional screen to configure an API Client input layout for the following
methods: POST, PUT, and PATCH.

5. Once done, click Next, and you will be led to the Pagination Options screen.

Here, you can select the type of pagination that has been specified by the API providers. Astera API Management offers
the following pagination types.
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6. When done, click Next, and you will be taken to the Service Options screen.

11.2. Making API Calls with the API Client Object in Astera API Management 221



Data-Services

Request Options -

Request Delay: Delay time (in milliseconds) before sending a request.

Retry Count: Number of retry attempts to be made in case of a time-out error.

Retry Delay: The duration (in milliseconds) between each consecutive retry attempt.

Continue on Retry Failure: Check to succeed the flow even after all retries have failed.

Use Parallelism: Check this option to send requests in parallel. Check this to send requests in parallel. Number of
requests to be sent in parallel (max limit of 10).

Follow Redirect: Check to allow forwarding a 3xx response to the redirected URL.

Include Authentication: Check to include authentication in the redirected API call.

Redirect Limit: Number of allowed redirect calls from a request. -1 indicates no limit.

Keep Connection Alive: Check to keep the TCP connection open to reuse for all subsequent requests to the same server.

Enable E-Tags: To learn about E-Tags, click here.

Retrieval: Check this to enable e-tags to request caching for GET requests.

Updates: Check this to enable request concurrency control using etags for PUT, PATCH or DELETE requests.

Response Options -
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Ignore HTTP Status Codes: Selecting this option will show and allow processing responses other than 2xx in the flow,
which are otherwise considered an error.

Include Content as String: Adds a field for serialized response content string in the Response-Info output node.

Include Response Headers: Adds all response headers as a collection in the Response-Info output node.

Include Raw Bytes: Adds a field for response content in the form of raw bytes in the Response-Info output node.

7. Click Next, and the Config Parameters screen will appear.

Config Parameters can enable the deployment of flows by eliminating hardcoded values and provide a dynamic way of
changing multiple configurations with a simple value change.

8. Click OK, and the API Client object will be configured.

Now, right-click on the API Client object’s header, and select Preview Output.

Your request has been executed successfully, as you can see that the HTTP status code is 200 which means that the API
Client has successfully carried out the GET request for the provided status.
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This concludes our discussion on making API calls with the API Client object in Astera API Management.

11.3 API Browser

11.3.1 What is an API?

API (Application Programming Interface) is defined as an interface or medium through which one software commu-
nicates with another. In other words, it is a set of contracts that allows different software systems to share information
with each other. The greatest advantage of an API is that different programs and devices can communicate with each
other in a secure manner, without interference.

APIs are messengers that conform to the technical contract between two parties. They are language and platform-
independent, which means C# can talk to Java, and Unix can communicate with Mac without any difficulty. An API is
not the same as a remote server. In fact, it is part of a remote server that receives requests and sends responses. More
precisely, an API is a structured request and response.

11.3.2 API Browser in Astera API Management

The API Browser in Astera API Management has narrowed down the steps to make HTTP calls using just one-step
authentication. Once you have imported an API in API Management, all endpoint operations in that API are populated
at once. API definition describes what requests are available and what the responses will look like.

So, once you load an API definition, all supported methods are populated in the API Browser unlike Legacy, where all
supported methods must be configured separately in each object.

There are two methods of configuring APIs in Astera Centerprise. For open APIs, you only need to provide the API
Import Source and File Path or Base URL to configure the connection with a specific API. Once this standardized
information is provided, any API that you have imported will populate in API Management’s API Browser, along
with their methods, for example, GET, PUT, POST, PATCH, and DELETE, and they will remain accessible until their
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authentication period expires. From the API Browser in Astera API Management, you can simply drag and drop
operations, and use them in your flows.

It is important to note that a project must be created before importing APIs to work with the API Browser. However,
you can access the API without a project when it’s an API Connection contained in the flow.

The API Browser, along with all its features and functionalities, works only within the scope of a project. Otherwise,
it will give you the following error,

When a user imports an API, a shared connection file is created within the project automatically. The shared action file
contains the Base URL of the imported API.
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HTTP Request Methods

Astera Centerprise supports the following HTTP request methods:

1. PUT: To update data to a specified resource to be processed on an API.

2. GET: To retrieve data from a specified resource on an API.

3. POST: To create or update an existing record on an API.

4. DELETE: To delete a specified resource on an API.

5. PATCH: To apply partial modifications to an existing resource.

11.3.3 Creating a Project for API Browser

To work with the API Browser in Astera API Management, you must first create an API Client Project.

Follow the steps below to create an API Client Project in Astera API Management,

1. Go to Menu Bar > Project > New > API Client Project.

Provide a name to the API Client Project and point the path to the location and directory where you want to save it.

Note: It is best practice to always create a new project in a new folder to avoid any errors.

2. Now, open the API Browser panel on your API Management client from Menu Bar > View > API Browser.

3. Once selected, an API Browser panel will open on the left side of your API Management client window.
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Here, you can see three icons in the toolbar of the API Browser,

Import API: By clicking this option, you can import different APIs with various available options.

Remove API from Browser: This option removes the selected API from the API Browser.

Refresh API Tree: This option allows you to redraw the browser tree after you have deleted some operations.

Expand/Collapse all: These options show/hide all the requests in the CAPI file.

Add Request: This option allows you to add a new HTTP request to the CAPI file by specifying the request name,
resource, and HTTP method.

Edit Properties: You can use this option to change the shared connection or the API name of the CAPI.

Open API Connection: This option allows you to directly open the shared API Connection from the project for the API
opened in the API Browser.

Save CAPI file: Any changes made to the CAPI file are saved when you click on this option.

How to Import APIs in API Management

To import an API in Astera API Management, click the Import API icon. An Import API screen will open.

Here, first, you need to select the API Import Source type from the drop-down menu. Astera API Management offers
three ways to import APIs.
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Type 1 – JSON/YML File

JSON/YML File – For this type of API source you only need to provide the Open API Specification File Path in JSON
or YML file formats.

2. Specify the File Path and click OK.

This API will be populated in the API Browser panel from where you can simply expand the nodes and drag-and-drop
methods onto your designer window.
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Type 2 – JSON/YML URL

JSON/YML URL – For this type of API source, you will need to provide the URL in JSON or YML format.
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2. Specify the URL and click on OK.

This API will be populated in the API Browser panel.
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Type 3 – Import Postman API Collections

Let’s see what steps are required to import a Postman Collection to the API Browser.

Open an Integration Project.
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Open the API Browser through View > Data Service > API Browser.

232 Chapter 11. API Consumption



Data-Services

Click on the Import API option on the API Browser.

This will open the Import API window.
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Select Postman collection from the drop-down of the API Import Source.

Browse and provide the path to the Postman Collection and click OK.

If there is already a Shared Connection available, then we can re-utilize it, instead of auto-generating a new one, by
clicking on the Use Existing Connection check box.

Once the Postman Collection is successfully imported, it will populate the API Browser with the available endpoints.
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Note: It is recommended by Postman to export the collections in v2.1 format files. Therefore, Centerprise restricts the
user to import only a v2.1 Postman Collection.

The Centerprise API file (.capi) and Shared Connection files will automatically generate and be saved in their respective
folders.
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Now, drag and drop any endpoint onto a logic designing artefact i.e., a dataflow to consume.
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11.3.4 Postman Collection Format

Variables Convention

To import a Postman Collection to the API Browser successfully, we must follow certain conventions:

The Postman collection must include a variable namely baseUrl. (This variable is case insensitive)

Note: A collection in which the baseUrl variable contains a special character(s) will not be imported.

All other variables, except for the baseUrl, will be discarded.

During the import, the baseUrl variable defined in all the endpoints will be replaced with the Base Url text box value
in the Shared Connection.

This means that the Shared Connection’s Base Url will be populated with the baseUrl variable’s Current Value that is
defined under the Variable section in the collection.
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Preservation of Authentication Information

All valid Postman Collections will be imported with pre-configured Shared Connections. These Shared Connections
will have the same Authentication Type selected as in the collections i.e., API Key, Auth Code, Client Credentials, etc.

Note: Confidential data such as credentials are imported for security and protection.

Example of an API Key Security Type
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Example of an OAuth 2.0 Security Type
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Preservation of Endpoint’s Configuration

On importing a Postman Collection, each endpoint’s configuration i.e., methods, resources, parameters, and re-
quest/response payloads will also be preserved.

HTTP Method and Resource

Parameter

All parameters with their respective default values are populated in the API Client’s Parameter window.
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Note: Sensitive data such as the URI parameter value is not preserved for security.

Payload

The input and output layouts/payload are structured in the respective Input and Output Layout windows. Additionally,
the sample text bodies used to generate the layouts are preserved in the Sample JSON Text window.
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Type 4 - Create or customize API collection:

Users can create and maintain custom API collections in case the API provider does not offer existing documentation
for its APIs.

1. From the API Browser, open the import wizard and select Custom API as the API Import Source.

2. Next, provide a name for your custom API and the base URL of the API provider. On import, a new API shared
connection (.sact) and a Custom-API (.capi) file will be created in the project.

Alternatively, the custom API can also point to an existing pre-configured connection from the project.

You can configure the API connection object in the shared connection file by providing valid authentication and defining
parameters if need be.
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Once you are done configuring the connection object, the CAPI file will open in the API browser.

To add API requests to your custom CAPI file, click on the Add Request icon from the top toolbar menu of the API
browser.

Here, define the request properties,

Request Name: This is used as the request name and description.

Resources: The unique request resource path including the URI or path parameters which appends after the Server
Base URL.

HTTP Method: Select the standard HTTP method to be used for this request.

The request will be added to the CAPI file in the API Browser. Repeat this process to add all the required requests in
your CAPI file.

Once you have populated the requests in your CAPI file, it may look something like this in the API browser.
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Note: You may have to include a URI parameter in the resource for some requests. Some API documentations display
the URI parameter after a (:) symbol. However, you will have to replace the colon ( : )with curly brackets ( {} ) for the
parameter to be considered as URI.

To configure the parameters, input/output layout, or pagination options for any request, right-click on it and choose the
Edit Request option.

You can also configure and save the request properties by dragging and dropping.

• Drag the request from the API browser to a flow designer.

• Right-click on the API Client and select Properties. Make changes to the properties of the API client object.

• To save the changes, just drag and drop the client object back to the API Browser from the flow designer.

Once you are done populating your Capi file by configuring all request properties and authentication, click on the Save
Capi file icon on the top of the API browser to save your changes.
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This will save all the configurations you have made including parameters, input/output body, and pagination settings
to the request.

Sharing and adding the Capi file to a new project

• Fully configured CAPI files act as a connector for your API provider. If you want to add the Capi file to another
project, right-click on the CAPI file from the project explorer and click on copy full path.

• Then open the other project, right-click on the folder you want to add the CAPI file to and click on Add Existing
Items.

• A box will open. Paste the file path in the box next to File name and click on Open.

The CAPI file will be added to the project along with its corresponding Sact file.

This concludes the basic concepts of working with the API Browser in Astera API Management.

11.4 Request Service Options - eTags

11.4.1 What is eTag?

An eTag also called an entity tag is an HTTP response header field that includes an identifier for the specific version
or the state of the resource at the time the request was sent. This identifier helps to differentiate between the different
versions of the resource and to check if the caches at the client side hold the updated representation of the state of the
resource.
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11.4.2 How do they work?

Let’s try to understand what is meant by eTags and how these options work.

If the client wants to check if the caches of a resource are usable or fresh, it can send the eTag in the If-None-Match
header field in the request to the server. The server will match the client’s eTag with the one that it has for the current
version of the resource. If the ETags match, the server will not send any representation of the state of the resource in
the response implying that the client’s caches are fresh and usable.

11.4.3 Two eTag Use-Cases

There are two major uses of eTags in API requests:

• Data Caching

• Concurrency Control.

Let’s investigate these uses one by one. For now, let’s see how this Data Caching works with a use case.

If None Match eTag

So, we will make an API call to one of the endpoint operations of Box APIs. Here, we have a dataflow in which we are
making an API call to fetch file details from one of the files on our Box account.

We will send a GET request to the /file/{fileid} resource with the help of the API client and API connection object. We
have configured the API connection object in a shared action file. From the API documentation site, we can see that
Box supports OAuth 2 authentication and the grant type of authorization code. Hence, we have already generated our
access code after providing the client credentials from our Box app.

Coming back to our flow, let’s open the properties of the API Client object. Here, we are using the shared action API
connection object that is providing the base URL. We have specified the HTTP method of GET and provided the name
of the resource. Here, the curly brackets specify that the path parameter of file id will be passed along the request to
fetch the information on the file related to that file id. In our flow, we are providing the file id through the constant
object.

From the API documentation of Box APIs, we can see that the if none match header is supported for the endpoint at
which we are making a call in our dataflow.
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Now, if we go to the Service options screen of the API Client object, we can see that we have a checkbox to enable
eTags which further gives us two checkboxes of,

• Retrieve if None Match Header

• Update Using If-Match Header.

We need to enable the eTag and the If-None-Match header checkbox.

When the request is sent to the server to fetch the file information for the first time via the GET API request, the response
will be returned with an eTag value. This eTag value along with the response will be stored in the response caches at
the client side.

• The field of “Is cached response” in the response info node will be returned True because we are making the call
for the first time and receiving the response from the server that will be cached.

• In the future, if the client makes an API call again to fetch the file information, the eTag in response caches will
be first compared with the latest eTag from the Server. So, for the consecutive API calls having the same cached
eTag, we will see the “Is Cached Response” field as true.

• In case, the file has not changed or updated, and the caches are reusable. The server will send a No modification
response as we can see in our job trace. This means that the server does not have to send the requested information
again in the response instead the client can use its response caches.
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So, this is how eTags help to prevent unnecessary download and retrievable of information in turn saving the server’s
bandwidth and request processing time.

If-Match eTag

Let’s look at another use case of eTag related to concurrency control.

It is possible that more than one client is sending requests to update the resources of the server. Then, to prevent loss
of changes and to detect simultaneous updates, the client can send an eTag in the If-Match header field in the request to
the server, if another client updates the resource in between or the file is modified, the server can compare the client’s
eTag with its own current one and if they don’t match, the server can prevent clients from overwriting the changes or it
will ensure that the latest version of the resource gets updated.

Let’s try to understand it with the help of a use case.

• We will make two update API calls to change the name of a file uploaded at our Box account. But, in between
the two calls we will make some changes to the file at the server side and see how the eTags play their part in
ensuring consistency.

• Here, we have a dataflow in which we are making a PUT request to update the name of the file associated with
the file ID of “983656708053” on our Box account. From the API documentation, we can see that the if-match
header field is supported in the PUT /file/{fileid} endpoint of Box APIs so in the API client service options, we
will enable the If-Match Header checkbox.

• The API client first checks if an eTag and response corresponding to this endpoint URL already exists in the
cache. In the job trace, we can see that there is no eTag in the response caches because we are making the update
request for this file for the first time.

• Behind the scenes, the client first makes a Get call to the same endpoint URL and stores the eTag and response
in its cache. Next, a PUT request is sent to the same endpoint URL including the eTag received earlier as the
value of the If-Match header.
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• The server processes the update request and the eTag and the response returned is cached as the eTag received
matches to the most recent version of the resource at the server.

This concludes our discussion on the eTag request service options and how they help with response caching and main-
taining concurrency control in Astera API Management.
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11.5 HTTP Redirect Calls

11.5.1 What is an HTTP redirection?

HTTP redirection, also known as URL forwarding, allows an API to provide more than one URL location to the resource
in the response. HTTP redirects usually happen due to temporal or permanent unavailability of the application, website,
or pages. For example, unavailability due to server maintenance or re-organization of the URL links.

Redirect responses from the server have a 3xx series HTTP status code along with a Location header parameter that
provides the URL to the resource’s new address.

11.5.2 Use Case

In this use case, we have a GET API resource account that returns account details based on the provided ID Query
parameter.

On previewing the API Client, a request is sent to fetch the account for the given Id. In the response returned the API
request is redirected returning a 302 Found status code response indicating that the resource is temporarily unavailable.

It may be due to server maintenance or any other unforeseeable reason. We can see that the Location header parameter
is received with the response too. The Value of this header is the address to the alternative resource that must be
accessed to retrieve the required account details.
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Let’s see how we can configure the API client properties to automatically follow any redirect responses to the new URL
Location.

Enable Auto-Redirect Calls

Right-click on the API Client and select properties. Next, navigate to the Service Options window. Here*,* there are
multiple options available to configure the redirect call(s).

• Follow Redirect Calls From 3xx Code Responses – This option allows auto-redirecting a 3xx HTTP response to
the redirected location URL.

• Redirect Authentication Information – This option allows forwarding all the authentication details along with the
redirected call.

• Redirect Limit – This option allows us to specify a limit to the number of redirected calls followed.
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Let’s enable the redirect and authentication options while keeping the redirect limit as 1.
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Note: By default, the Redirect Authentication Information and Redirect Limit options are disabled. Only on checking
the Follow Redirect Calls From 3xx Code Responses option are they enabled for configuration.

Now, on previewing the output we can see that a 200 OK status response is received instead of a 302 Found. The request
URL field shows that the request was successfully auto-redirected to the redirecting URL.
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Now, let’s execute the data flow.

Here, we can see the job traces show all steps of the redirected calls including how the authentication information
was forwarded along with the request, what was the redirect limit, where the request was redirected to, and if the job
executed successfully.

Scenario 1 - No Authentication Information Redirected

Let’s consider a scenario where the redirected API requires authentication, and we don’t send the authentication in-
formation along with the redirect call by unchecking the Redirect Authentication Information option from the Service
Options window.
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On executing the job, we can see that the request is redirected without the authentication information, and as a result,
the server sends back a 401 Unauthorized error response.
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Scenario 2 (Multiple Redirect Calls)

Now, let’s consider a scenario where an API request hops through more than one redirected call.

1. The first redirect request returns a 3xx series response. We can see in the Job Trace that on redirecting the request
we received a 307-status response indicating that the service is temporarily unavailable. As the redirect count was set
to 1 so, only one redirect call was sent by the API Client.

2. In such a situation, we need to follow all the redirect requests until a 200 OK response is received. For that, we can
increase the Redirect Limit count.

For example, we will set the limit to 2 and send the request.

In the Job Progress window, we can see that two redirect calls have been exhausted, but we still received a 307-status
response.

Let’s increase the limit to 3 and send the request.
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Finally, a 200 OK response is received on the third redirect call.

This concludes the article on how HTTP redirect calls are automated by the API Client in Astera API Management.

11.6 Method Operations

In this article, we will be discussing various HTTP methods. We will see how HTTP requests can be made through the
API Client object in Astera API Management.

For our use cases, we have made use of the Petstore Open-API definition. We can import the API to the API Browser
using its import URL.

Once done, it automatically establishes various pre-defined endpoints as API Client objects. They can then be dragged
and dropped onto a dataflow for further configurations and transformations.
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Note: When imported, a shared connection object will also be created containing the base URL and authentication
details.

To learn more about importing a URL to the REST API Browser, click here.

11.6.1 Making a GET Request

1. First, drag and drop the Get a file’s metadata or Content by ID endpoint from the browser onto the dataflow.
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In this scenario, we want to get metadata for a file with file**ID,

“184Gi7q9iPQyiR6lkG3bdSi5z3-9eeT-d”.

For this, we will pass the relevant fileID using a ConstantValue object.

2. To explore the API Client object for this method, right-click on the object’s header and select Properties.
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This will open the API Client screen where the connection info of your API is defined.
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The Shared Connection, Method, and Resource here are already configured. Notice that Resource consists of ‘files’
along with the ‘fileid’ URL parameter.

11.6. Method Operations 261



Data-Services

3. Click Next.

Here, the ‘fileId’ URL parameter follows from the defined resource.

For our use case, we will use this parameter to get details for a pet.

Click Next to proceed to the Output Layout screen, where you can view the Response Layout of your API. There are
two ways in which you can generate the output layout if required.

• The first one is by providing sample text by clicking the Generate Layout by providing Sample Text option.
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• The other way to do this is by running a request by clicking the Generate Layout by running Request option.

4. Click Next to proceed to the Pagination Options screen.

For our use case, we have selected None.
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5. Click OK.

6. You can preview the data by right-clicking on the object and selecting Preview Output from the context menu.
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As seen below, the GET request that was made, has fetched data according to the user application.
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11.6.2 Making a POST Request

Now, let’s try creating a new file.

1. Drag-and-drop the POST method as an API Client object and open its properties.

We will pass the required parameters to the POST request object using a Variables object.
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2. Now, right-click on the API Client object and select Preview Output.

You can see that the HTTPStatusCode is “200”, which means that the API has successfully carried out the action
requested by the client.

Let’s verify it by making a GET request for the same FileId that we had posted earlier.
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You can see that a GET request for FileID has returned the same information that we had posted.

11.6.3 Making a DELETE Request

Now, let’s try making a DELETE request.

1. For this, we will first make a GET request to check whether that file exists in the records before we try to delete this
record.

We will pass a fileId using a ConstantValue object.
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2. Right-click on the API Client object and select Preview Output.

It has fetched the details of the file with the fileId and the status shows that the field is available.

To delete this file record, we will drag and drop another DELETE API Client object onto the flow and configure its
Properties according to the DELETE method.
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3. Pass the fileId to the DELETE request object using a ConstantValue object.
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4. Right-click on the API Client object and select Preview Output. You can see that it has returned HTTPStatusCode,
“204”, which indicates successful execution.

Let’s verify it by making a GET request again, and check if the fileId, has been deleted.

5. Right-click on the API Client object and select Preview Output.
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You can see that Centerprise has returned error 404 which means that there is no pet found with PetId, “5”, and the pet
record has been successfully deleted from petstore API.

You can see that API Management has returned error 404 which means that there is no fileId found, and the file record
has been successfully deleted from Google Drive API.

11.6.4 Making a PUT Request

Let us now look at the PUT HTTP Method.

1. Drag and drop the GET endpoint from the API Browser onto the dataflow.
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2. Right-click on the object and select Properties from the context menu.

3. Click Next, and the Parameters screen will appear.

For this use case, we will update the file with a fileId. Let’s define this ID in the Default Value field.

4. Click OK and preview the output by right-clicking on the object and selecting Preview Output

11.6. Method Operations 273



Data-Services

As you can see in the preview screen below, the GET method has retrieved the file Metadata by ID.
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5. Now, drag and drop the relevant endpoint from the API Browser onto the dataflow.

For our use case, we will be using this Patch object for the PUT method so we can update the ID.

Right-click on the object and select Properties from the context menu.

Our Shared Connection has already been defined. The HTTP Method is Put, and the Resource to update is a file.

6. Click Next, and you will be led to the Output Layout screen

We have defined the FileId here that we wish the resource to be updated to,

If required, an output can be generated by running a request using the available option.
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9. Click OK, right-click on the object, and select Preview Output.

As you can see here, the fileId has been updated,

10. We will now preview the output of the GET object we have configured to verify if the pet status has been updated.

As you can see, the value has been updated.
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11.6.5 Making a PATCH Request

Let’s make a GET request to see what information is there in the File ID where we want to update something.

1. To make a GET request, drag-and-drop the GET API Client object onto the dataflow.

2. Pass userID ‘1pGLAWbY7zu1nYFjMFB5GmTjVK2kXGHP1’ to the id under the Parameters node in the API
Client object using the Variable transformation object.
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3. Right-click the API Client object’s header and select Preview Output.
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Here is what the output looks like:

4. Drag-and-drop the Update a file’s metadata API Client object to use the PATCH method.
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5. Pass fileId’ 1pGLAWbY7zu1nYFjMFB5GmTjVK2kXGHP1’, and name, “Astera”, using a Variables resource ob-
ject.

6. Right-click on the object’s header, and select Preview Output.
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You can see that the HTTPStatusCode is 200, which means that the API has successfully carried out the PATCH request.
Let’s verify it by making a GET request for the same fileId which we altered.

7. Right-click the APIClient object’s header and select Preview Output.

As you can see, the request has been successfully carried out and the email address has been updated.
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This concludes our discussion on the HTTP method operations in Astera API Management.

11.7 Pagination

Pagination refers to managing the traffic of records coming from a source. It divides the records into a discrete number
of pages so that they are comprehensible for a user.

Pagination is not supported by all APIs. For those that do support it, Astera offers four types of paginations.

11.7.1 Offset

This type of pagination requires two parameters: A Limit and an Offset value to be specified by the user. A Limit
specifies the number of records that you want to fetch in a one-page request, and an Offset simply tells the number of
records to be skipped before selecting records.

Offset Parameter: Select the offset parameter of the API that you are working with, as specified on the Parameters
screen.

Initial Offset: The record index from which you want to start your pagination.

Limit Parameter: Select the limit parameter of the API that you are working with, as specified on the Parameters screen.

Limit: Number of records on a one-page request.

Number of Pages: The number of pages indicates the number of request iterations which you want to be processed.
Each iterative request incrementally adds the respective offset and limit values for the next set of records page.
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Read till end: Check this option if you want to fetch all the records. Selecting this will disable the ‘Number of pages’
option and all the records will be returned as requests are sent in a loop till no more data is found.

Repeating item: This option is only enabled when you check the Read till end box. You can choose a repeating item
or the collection node of the data from the output layout of the API client object. The repeating item helps the API
client recognize the end of records, as whenever an empty response node is returned, the client stops sending further
requests, and pagination ends.

11.7.2 Cursor

This type of pagination generates a token to indicate a pointer for the next page of records. You can set a limit to the
number of pages you want to process.

Cursor Field: Here, you can specify the field from the output layout which contains the cursor from the server response.

Cursor Parameter: Here, you can select the parameter to be used to send the cursor value received in the previous
request of the API that you are working with, as specified on the Parameters screen. Alternatively, you can choose to
send the cursor as an input body layout field by selecting the ‘Use Input Body Parameters’ checkbox.

Number of Pages: Here, you can specify the number of pages or the number of requests to be made iterating over the
data set. Additionally, you can simply check the Read till End option if you want to fetch all records without specifying
the number of pages.
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11.7.3 Next URL

This type is the same as Cursor pagination, except that it generates a URL instead of a token for every subsequent page.

Next URL Field: Here, you can specify the field from the response layout that contains the URl to fetch the next set of
records.

Number of Pages: Here, you can specify the number of pages or requests you want to fetch, or you can simply check
the Read Till End option if you want to fetch all records without specifying a page number limit.
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11.7.4 Page Number

In this type of pagination, you can specify the number of pages you would like to fetch in one go.

Page Number Parameter: Here, you can specify the page number parameter of the API that you are working with, as
specified on the Parameters screen.

Start Page Number: The page number from where you want to start fetching your output, or the lower limit.

End Page Number: The page number where you want to end.

Read till end: Check this option if you want to fetch all the available records. Selecting this will disable the End page
number option and make requests till no data is returned.

Repeating item: This option is only enabled when you check the Read till end box. You will be required to choose a
repeating item, which can be one of the collection nodes from the output layout of the API client object. The repeating
item helps the API client recognize the end of records, as whenever an empty response node is returned, the client stops
reading the response and the pagination ends.
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This concludes our discussion of pagination for APIs in Astera API Management.

11.8 Raw Preview And Copy Curl Command

11.8.1 Raw Preview Request/Response

The raw request and response preview features allow API developers to view the exact request and response payloads
being exchanged between clients and servers in their APIs.

This feature provides a detailed look at the headers, body, parameters, and metadata of the HTTP request and response,
which can help API developers debug issues, test APIs, and optimize performance. By using raw preview request and
response capabilities, API developers can gain a deeper understanding of how their APIs are being used and troubleshoot
issues quickly and efficiently.

Raw Preview in Astera API Management

Astera API Management lets the user preview the Raw request and Raw response both from the API Client object.

1. Drag and drop an API Client object and configure it.

For our use case, we have used an API Client making a GET Call to a resource.
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2. Right-Click on the object and select Preview Raw Request.
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This will show the raw request in the Raw Data Preview window.
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As you can see, it has shown the HTTP method as well as the resource, host server details, and the Content-Type of the
Request.

It even shows us tabs on the Request, Parameters, and Body.
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3. To preview the raw response, right-click on the API Client object and select Preview Raw Response from the context
menu.
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This will generate a raw response in the Raw Data Preview window.
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As you can see above, the raw response has been generated, which shows us the entire HTTP response in raw form. It
even has tabs that show us the Parameters, body, and response info.

11.8.2 CURL Command

Curl is a command-line utility that can be used to send HTTP requests to APIs and retrieve the respective responses.

It allows API developers and testers to easily interact with APIs and perform tasks such as testing, debugging, and
troubleshooting. Curl supports various HTTP methods such as GET, POST, PUT, and DELETE, and can handle HTTP
headers, cookies, and authentication.

It is a simple yet powerful tool that is widely used in API development and management.
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Copy CURL in Astera API Management

Astera API Management lets the user copy and view the CURL command from the Raw Data Preview window to help
in comparing and debugging results from any external clients such as Windows command prompt or Postman.

Note: The Copy CURL Command option is available in the raw request preview.

This concludes Raw Preview and Copy CURL in Astera API Management.

11.9 Open APIs – Configuration Details

Note: Client Secret, Access Token and API Key are to be generated by the user, and will be unique for
every application. The values specified below are just for example.

11.9.1 Adafruit IO

Authentication Type: API Key

• Import API: https://raw.githubusercontent.com/adafruit/io-api/gh-pages/v2.json

• Authentication: API-KEY

• Key: X-AIO-Key

• Value: aio_UTqF73klycqdLWpbp0wLl7RHKV25

• UserName: [Enter you user name]
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• FeedKey: [Enter your feed key]

• Adafruit Login Page: https://accounts.adafruit.com/users/sign_in

• Email: [Enter your login email]

• Password: [Enter your password]

11.9.2 Avaza API

Authentication Type: OAuth 2, Authorization Code

• Import API: https://api.avaza.com/swagger/docs/v1

• Authentication: oauth2 (Access token will be valid for 1 day)

• Token URL: https://any.avaza.com/oauth2/token

• Auth URL: https://any.avaza.com/oauth2/authorize

• ClientId: [Enter client ID]

• Client Secret: c1d4b723790f0e24d0b2df68ebde613e9533

• Avaza Login Page: https://any.avaza.com/account/login

• Email: [Enter your email]

• Password: [Enter your password]

11.9.3 BOX API

Authentication Type: Bearer Token

• Base URL: https://api.box.com/2.0

• Authentication: Bearer Token (Access token will be valid for 1 hr)

• Token: 1IVYyDgfDPyWpoXe9c4RMOt7tmtiB75q

• Steps to generate access token:

• Page: https://app.box.com/developers/console/app/984015/configuration

• Email: [Enter your login email]

• Password: [Enter password]

• Click Generate Developer Token to generate access token

• API Reference: https://developer.box.com/en/reference

11.9.4 Facebook API

Authentication Type: OAuth 2, Authorization Code

• Base URL: https://graph.facebook.com/

• Auth URL: https://www.facebook.com/dialog/oauth

• Access Token URL: https://graph.facebook.com/oauth/access_token

• Client ID: 217423066002
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• Client Secret: d7d8969c6ea31bf117f04768b63bb

• Credentials to use when using ‘Request Token’

• Email address: [Enter your email]

• Password: [Enter your password]

11.9.5 Google Drive

Authentication Type: Bearer Token

• Base URL: https://www.googleapis.com/drive/v3

• Authentication: Bearer Token (Token will be valid for an hour)

• Token: ya29.Il_AB6CICAcAQD6lKoQCW3K2DO_enBd3be5G2Vvd0hZ3Q8US4eHL-
PEOS1qRD7zzSEN3t_qb_eNqWzZS3zsXP_FcAHA9TSoy-tDpsWv0RnWRledPhZqRt79f9X

• API Reference: https://developers.google.com/drive/api/v3/reference

Steps to generate access token:

1. Go to https://developers.google.com/oauthplayground/

2. Select the APIs you want to authorize and click Authorize APIs.

3. On the next screen, provide your credentials.

4. Email: [Enter your login email]

5. Password: [Enter your password]

6. Now click Exchange authorization code for tokens to generate access token.

11.9.6 netAuth API

Authentication Type: API Key

• Import API: https://api.doc.nextauth.com/api/swagger.json

• Authentication: API-KEY

• KEY: [Enter API Key]

• VALUE: J5znqilK_qUt65iQyy9W2Q

• Help link: https://api.doc.nextauth.com/

11.9.7 OMDb API

Authentication Type: API Key

• API key to be passed as a query parameter

• JSON File: http://www.omdbapi.com/swagger.json

Steps to generate API Key:

1. Open http://www.omdbapi.com/apikey.aspx?__EVENTTARGET=freeAcct&__EVENTARGUMENT=&__LASTFOCUS=&__VIEWSTATE=%2FwEPDwUKLTIwNDY4MTIzNQ9kFgYCAQ9kFgICBw8WAh4HVmlzaWJsZWhkAgIPFgIfAGhkAgMPFgIfAGhkGAEFHl9fQ29udHJvbHNSZXF1aXJlUG9zdEJhY2tLZXlfXxYDBQtwYXRyZW9uQWNjdAUIZnJlZUFjY3QFCGZyZWVBY2N0x0euvR%2FzVv1jLU3mGetH4R3kWtYKWACCaYcfoP1IY8g%3D&__VIEWSTATEGENERATOR=5E550F58&__EVENTVALIDATION=%2FwEdAAU5GG7XylwYou%2BzznFv7FbZmSzhXfnlWWVdWIamVouVTzfZJuQDpLVS6HZFWq5fYpioiDjxFjSdCQfbG0SWduXFd8BcWGH1ot0k0SO7CfuulN6vYN8IikxxqwtGWTciOwQ4e4xie4N992dlfbpyqd1D&at=freeAcct&Email=

2. Select Account Type, ‘FREE.’

3. Enter your email address.
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4. Enter your first name and last name.

5. Describe in a few words your purpose of using this service.

6. Click Submit.

7. You will get the API Key in your email with a link to activate it. Click on this link and the key will be activated.

11.9.8 Square Connect API

Authentication Type: Bearer Token

• Import API: https://raw.githubusercontent.com/square/connect-api-specification/master/api.json

• Authentication: Bearer Token

• Token: EAAAEPXVtza2Utrx-GJ90Az4sCQ_NLbLYOKANVFmJiPGJ1Z6B-eJgZ-2V1

• Use this API to import: https://raw.githubusercontent.com/

Note: This looks like an issue with Square Connect’s documentation because the ‘Import API’ option does
not work.

11.9.9 Zendesk API

Authentication Type: Basic Authentication

• Username: [Enter username or login email]

• Password: [Enter password]

11.10 Authorizing Facebook APIs in Astera Centerprise

Facebook uses HTTP-based APIs that can be utilized to extract or load data, to and from Facebook. You can configure
Facebook APIs for use in Astera Centerprise using the ‘Custom API’ source in the REST API Browser (Beta).

To authorize a Facebook API in Astera Centerprise, follow the steps below.

1. Go to this Url: https://developers.facebook.com/ and log in.

Note: If you have not created an account yet, you need to create one first after signing in.

296 Chapter 11. API Consumption



Data-Services

2. Enter your Facebook account credentials to log in.

3. Go to My Apps > Create App to create an application.
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4. Provide the Display Name for your application, and click Create App ID.

Once your application is created, it will show under the My Apps tab.
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5. Click Centerprise to open the dashboard.

Reference Url: https://developers.facebook.com/apps/217423066002800/dashboard/

6. Click on Settings > Basic to get the relevant credentials.

Reference Url: https://developers.facebook.com/apps/217423066002800/settings/basic/
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7. Here you can see the App ID and App Secret. Save this information to use later for authentication.

8. To use Bearer Token authentication, go to Tools > Graph API Explorer.

Reference Url: https://developers.facebook.com/tools/explorer/

9. Click Generate Access Token and copy the token.
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10. To access and try out different APIs, go to Tools > Graph API Explorer.

Reference Url: https://developers.facebook.com/tools/explorer/

11. Select anything from the drop-down list.
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12. Click Submit, to see the results.

13. Import the API in Centerprise using the Import API option in the REST API Browser (Beta). Select API Import
Source as Custom API by providing Name and Base Url. To learn more about how to work with custom APIs in
Centerprise, click here.

Base Url: https://graph.facebook.com/
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14. Now, you need to authenticate the Facebook APIs to use them in your dataflow. Without authentication, you will
get an error. To authenticate an API, go to the Project Explorer panel and double click on the API’s .sact file under the
Shared Connection node.

Facebook’s .sact file will open on the designer. Now, right-click on the shared action file’s header and select Properties.
This will open the REST API Connection window, where you can configure the settings to authenticate Facebook’s API.
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Facebook uses ‘OAuth 2’ authentication with Grant Type, ‘Authorization Code’.

Auth Url: https://www.facebook.com/dialog/oauth

Access Token Url: https://graph.facebook.com/oauth/access_token

Provide ClientID and Client Secret that you had saved earlier, then click on Request token to generate the access token
for Facebook.
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Note: As you click on Request Token, Facebook’s login window will open where you will have to provide
your credentials to generate the access token to access Facebook API.
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15. Save the shared action file after authentication and you are ready to use Facebook APIs in Centerprise. For more
information on how to use a Custom API in Centerprise, click here.

This concludes authenticating the Facebook APIs in Astera Centerprise.

11.11 Authorizing Centerprise’s Server APIs

Follow the steps below to learn how to authenticate Centerprise’s Server APIs.

1. Right-click on the server name in Server Explorer > Server Connections > DEFAULT >
HTTPS://(ServerName):9260.
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2. A wizard will appear with the Centerprise Server API Path. Click on the copy icon located at the bottom-left of the
wizard to copy it.

A message will appear to confirm that the text has been copied successfully. Click OK.

11.11.1 Importing APIs in Centerprise

3. Click the Import API option in the REST API Browser and paste the Centerprise Server API path in the URL box.
Then click OK.

Note: Check the “Ignore certificate errors over HTTP/SSL” option to avoid any certification barriers.
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4. A wizard will appear, notifying you about the created shared action file. Click Yes to set it up.

You can also click on the .sact file in Project Explorer to configure the authentication settings.

The REST API Browser will be populated with Centerprise’s Server APIs, which you can use in your dataflow.
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5. Right-click on the Centerprise_Server object and select Properties.

310 Chapter 11. API Consumption



Data-Services

This will open the REST Connection screen. Select the Security Type as Bearer Token, as Centerprise Server APIs use
Bearer Token authentication.
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Provide the User Name, Password, and Token URL for Bearer Token. Then click Request Token to generate a token,
and click OK. Press Ctrl+S to save changes in the shared action file.

Note: You will have to regenerate the token if the validity period has expired.
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6. Now, drag-and-drop the /api/ServerInfo from the REST API Browser to make a GET request.
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7. Right-click on the object’s header and select Preview Output.
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This is how your output would look like:
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This concludes working with Centerprise’s Server API in Astera Centerprise.

11.12 Authorizing Avaza APIs in Astera Centerprise

The Avaza API follows REST protocol with ‘OAuth2’ authentication. It allows you to access contacts, projects, tasks,
invoices and taxes. In Astera Centerprise, you can configure an Avaza API through a swagger definition using the
Import API option in REST API Browser.

Let’s go over how we can authenticate an Avaza API in Astera Centerprise.

1. Create an integration project by going to Project > New > Integration Project.
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2. To import Avaza API in your Centerprise client, click on the following icon.

3. An Import API window will open. Here you will need to select your relevant import source. In this case, we will
import using the Json/Yml Url source.

Base URL: https://api.avaza.com/swagger/docs/v1
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You will see that all the APIs present on Avaza’s URL have been populated in the REST API Browser (Beta).
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4. Now, you need to authenticate the Avaza APIs to be able to use them in your dataflow. Without authentication, you
will get an error. To authenticate an API, go to the Project Explorer and double click on the API’s .sact file under the
Shared Connection node.
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The Avaza .sact file will open on the designer. Now, right-click the shared action file’s header and select Properties.

5. This will open the REST API Connection window where you can configure settings to authenticate Avaza API.
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Avaza uses ‘OAuth 2’ authentication. In the ‘OAuth 2’ Security Type, select one from the following Grant Type options:

1. Authorization Code

2. Implicit

In this case, we will be using the ‘Authorization Code’.

Note: Login to your Avaza account and go to Settings > Developer Apps > Add OAuth App to generate
the ClientID and Client Secret.

Auth Url: https://any.avaza.com/oauth2/authorize

Access Token Url: https://any.avaza.com/oauth2/token
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6. Now, click Request token to generate an access token and refresh token for Avaza.

Note: As you click on Request Token, Avaza’s authorization app will open where you will be required to
provide your credentials to be able to generate access token and refresh token to access Avaza.
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7. After authentication, save the shared action file, and you are ready to use Avaza APIs in Centerprise.

This concludes authenticating the Avaza APIs in Astera Centerprise.

11.13 Authorizing Square API in Astera Centerprise

Square API is an HTTP-based API that follows REST standards. It allows you to manage the resources of your Square
account by making requests to URLs representing those resources. You can configure Square API for use in Astera
Centerprise by providing its swagger definition using the Import API option in the REST API Browser.

1. After you have created the application in Square, go to Manage Properties.

2. Now go to OAuth properties in Production tab. Here, you have to provide the Redirect URL for the authorization
callback.

Note: Save Applicant ID and secret to use it later for Centerprise authentication.

Reference Link: https://developer.squareup.com/docs/oauth-api/overview
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3. Now create an integration project in Centerprise by following the instructions provided in this article. Also, import
the following swagger definition in REST API Browser:

Base Url: https://raw.githubusercontent.com/square/connect-api-specification/master/api.json

4. Go to the Square’s shared action file’s (.sact) properties to authenticate it in Centerprise. Click here to learn more
about how to work with APIs that require authentication.
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You can authorize Square API by using Security Type OAuth 2 or Bearer Token. In this example, we will be authorizing
using OAuth 2.

5. Set its Security Type as ‘OAuth 2’ and Grant Type as ‘Authentication Code’. Provide the application ID and secret
that you had saved in step 2.

Click on Request Token to get the access token to Square API.

Auth Url: https://connect//squareup.com/oauth2/authorize

Access Token Url: https://connect.squareup.com/oauth2/token

Additional Info: You can modify your authorization by mentioning names of only those permissions that you want to
access from your Square account in Centerprise. In case you want to access all of them, leave the settings at default.
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6. Once you get the access token, save the Shared Action file and you are ready to use Square API in Centerprise.

This concludes authenticating the Square API in Astera Centerprise.

11.14 Authorizing ActiveCampaign API in Astera Centerprise

The ActiveCampaign API is structured around REST, HTTP, and JSON. You can make requests by using URL endpoints
particular to a specific resource. The resources in ActiveCampaign are represented in JSON following a conventional
schema. In Astera Centerprise, you can configure an ActiveCampaign API using the Import API option present in the
REST API Browser.

ActiveCampaign does not provide an Open API definition so we will add a request manually by using a Custom API
in Centerprise.

To authorize an ActiveCampaign API in Centerprise, follow these steps:

1. Create an integration project in Centerprise by following the instructions provided in this article.

2. Create a Custom API and provide Base Url.

Reference link for Base Url: https://developers.activecampaign.com/reference#url
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3. Now, you need to authenticate the ActiveCampaign APIs to use them in your dataflow. Without authentication, you
will get an error. To authenticate an API, go to the Project Explorer and double click on the API’s .sact file under the
Shared Connection node.

The ActiveCampaign .sact file will open in the designer. Now, right-click the shared action file’s header and select
Properties.
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4. ActiveCampaign uses an API Key as Security Type. Specify your Key and Value.

Key: API-Token

Value: {Token}
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5. Click OK, and save the shared action file (.sact).

6. Add methods in REST API Browser panel which you want to use in Centerprise by adding requests, and you are
ready to use the ActiveCampaign API in Centerprise.

This concludes authorizing the ActiveCampaign API in Astera Centerprise.

11.15 Authorizing QuickBooks’ API in Astera Centerprise

The QuickBooks API is a RESTful API which allows you to read or write data to and from QuickBooks. It uses ‘OAuth
2’ authentication type. You can configure a QuickBooks API in Astera Centerprise by using the Import API option
present in the REST API Browser.

QuickBooks does not provide Open API definition, so we will add the request manually by using a Custom API in
Astera Centerprise.

We only need to follow steps from Development > Create and Configure an App from the following link:

Authentication steps: https://developer.intuit.com/app/developer/qbo/docs/build-your-first-app

Where the Redirect Url used in step 7 in the above link for Centerprise would be:

Redirect Url for Centerprise Server: http://{Server_Name}:8050/)

Note: Save ClientID and secret to use it afterwards in Centerprise authentication
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11.15.1 Follow these steps to authorize QuickBooks’ API in Astera Centerprise:

1. Create an integration project in Centerprise by following the instructions provided in this article.

2. Create a Custom API and provide a Name and Base Url.

Base Url (Sandbox): https://sandbox-quickbooks.api.intuit.com

Base Url (Production): URL:https://quickbooks.api.intuit.com

3. Now, you need to authenticate QuickBooks APIs to be able to use them in your dataflow. Without authentication,
you will get an error. To authenticate an API, go to the Project Explorer and double click on the API’s .sact file under
the Shared Connection node.

The QuickBooks .sact file will open in the designer. Now, right click on the Shared Action file’s header and select
Properties.
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4. QuickBooks uses ‘OAuth 2’ Security Type with Grant Type, ‘Authentication Code’.

Auth Url: https://appcenter.intuit.com/connect/oauth2

Token Url: https://oauth.platform.intuit.com/oauth2/v1/tokens/bearer

ClientID: {ClientID}

Client Secret: {Client_Secret}

Scope: {Scope}

State: {State}
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Additional Info - You can modify the authorization by mentioning names of only those permissions that you want to
access from QuickBooks in Centerprise.

Note: While working with QuickBooks APIs, it is necessary to specify Scope and State to generate the
access token.

5. Click OK, and save the Shared Action file (.sact).

6. Add methods in the REST API Browser which you want to access in Centerprise by adding requests and you are
ready to use QuickBooks APIs in Centerprise.

Reference Link: https://developer.intuit.com/app/developer/qbo/docs/api/accounting/most-commonly-used/account

This concludes authorizing a QuickBooks API in Astera Centerprise.
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11.16 Accessing Centerprise’s Server APIs Through a Third-Party
Tool

Astera Centerprise provides you with the flexibility to execute your jobs through a third-party tool, without using the
Centerprise client. Let’s learn how to achieve this in the article below.

11.16.1 Use Case

In this use case, we have our Centerprise client on a local machine and server installed on a virtual machine. Instead
of using Centerprise client, we will use Postman as a third-party tool to send REST requests to the server in order to
execute the job.

Workflow in Centerprise

The workflow document in Centerprise consists of a Variables object, a FileTransferTask object and a RunDataflow
object.

We will pass the name of the file that we want to download and process to the FileTransferTask from the Variables
object. The Variables object takes an input from the REST call sent through Postman, and passes it to FTP to download
the file with that name. We then pass the file path of the downloaded file to the RunDataflow object.

In the following section, we will cover a step-by-step overview of how you can achieve this.
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11.16.2 How to Execute a Job Using Postman

1. We will make the first API call for logging into the Centerprise server to generate an access token. Provide the
following credentials in the request body and click on Send.

• User: admin

• Password: Admin123

• RememberMe: 1

Centerprise server will provide you with an access token in response.

2. In the second step, we will send the path of the file that we want to download from FTP, in the form of a string, to
the Variables object.
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In the parameters:

• ActionName: Variables

Name of the object present inside the workflow to which the name of the file will be passed

• Parameters: sourceFilePath

The value of the input variable field inside the workflow

• Value: [file path of the file that you want to download]

The value of the input variable field inside the workflow

As soon as you send this API request, Centerprise will provide you with a jobID that you can use to get the job
status.

3. In the third step, we will make a GET call to fetch the job’s status by providing the job ID.

This is what Centerprise’s response would look like.
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This concludes accessing Centerprise’s server APIs through a third-party tool.

11.17 Centerprise’s Server API Documentation

11.17.1 Authentication

Centerprise’s Server APIs use Bearer Token authentication. To learn more about authenticating Centerprise’s Server
APIs, click here.

Resource: Account

Login

Method: POST

Endpoint: https://{servername}:{portno}/api/account/login

In this case: https://LOCALHOST:9261/api/account/login

Resource: /api/account/login

Request Body

Note: The format of our request body is JSON type.

Resource: Job

Status

Method: GET

Endpoint: https://LOCALHOST:9261/api/Job/{jobID}/Status

Resource: /api/Job/{jobID}/Status
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Required Parameter

Description: This method fetches the status of a job for the given job ID. A few of the response statuses are given
below:

1. Unknown

2. Invalid

3. NotStarted

4. Queued

5. Initializing

6. Running

7. Completed

11.18 NTLM Authentication

NTLM (NT LAN Manager) authentication is a Microsoft proprietary authentication protocol used to authenticate users
in a Windows-based network.

It provides secure authentication by using a challenge-response mechanism, where the server sends a challenge to the
client, and the client sends a response that is encrypted using a hash of the user’s password.

NTLM authentication is used in various Microsoft products, including Windows, Internet Explorer, and Microsoft
Office.

11.18.1 NTLM in Astera API Management

Astera also offers the ability to use NTLM authentication when establishing an API connection.

1. To start, drag and drop the API Connection object from the toolbox onto a dataflow.
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2. Right-click on the object and select Properties from the context menu.

This will open a new window,
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Base URL: Here, you can specify the base URL of the API which will prepend as a common path to all API endpoints
sharing this connection. A Base URL usually consists of the scheme hostname and port of the API web address.

Timeout (msec): Specify the duration, in milliseconds, to wait for the API server to respond before giving a timeout
error.

Include Client SSL Certificate: Selecting this option is going to include any Client SSL certificate that is needed for
authentication.

Enable Authentication Logs: Selecting this checkbox will allow the client to generate authentication logs when the API
connection has been configured.

3. Fill in the Base URL and open the Security Type drop-down menu,

For our use case, we have deployed an API on IIS Manager on another machine, and we will send a request to access
that API.

4. Select NTLM as the authentication type.

This will give us the following options,

Username: This field will input the same username that is used to login to Windows.

Password: The password associated with Windows login credentials.

Note: NTLM authentication establishes API connections using a challenge-response mechanism. When sending an
API request, Centerprise sends a hashed version of the user’s credentials (username and password) to the server, which
sends back a random challenge. Centerprise then mixes this challenge with the user’s password and sends back a hashed
value for verification. Access is granted if the validation is successful.

5. Click Ok and the API Connection object will be configured with NTLM Authentication.
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This API Connection can then be used in API Client objects to make API calls to the server and receive appropriate
responses in return.

6. Drag and drop an API Client object onto the dataflow and select the shared connection that was defined.

Note: The Resource will be ‘/’ since our entire address has been defined in the Base URL.
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7. Click Ok and preview the output of the API Client object.

As we can see in our data preview window, the request has been sent successfully and the response has returned as ‘200
OK’.

This concludes the working and configuring of NTLM Authentication in Astera API Management.
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11.19 AWS Signature Authentication

AWS Signature authentication is the process of verifying the authenticity of requests made to Amazon Web Services
(AWS) using the AWS Signature method.

This authentication process involves calculating a digital signature for each request using the requester’s access key and
secret access key, along with details about the request being made. AWS verifies the signature against the user’s access
credentials and grants access to the requested resources if the signature is valid.

The AWS Signature authentication method ensures that requests are securely transmitted and that only authorized users
can access AWS resources.

11.19.1 AWS Signature Authentication in Astera API Management

Astera API Management lets the user configure an API Connection with AWS Signature as an authentication type.

1. Drag and drop an API Connection object from the toolbox onto a dataflow.

2. Right-Click on the object and select Properties from the context menu.

This will open a new window,
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Base URL: Here, you can specify the base URL of the API which will prepend as a common path to all API endpoints
sharing this connection. A Base URL usually consists of the scheme hostname and port of the API web address.

Timeout (msec): Specify the duration, in milliseconds, to wait for the API server to respond before giving a timeout
error.

Include Client SSL Certificate: Selecting this option is going to include any Client SSL certificate that is needed for
authentication.

Enable Authentication Logs: Selecting this checkbox will allow the client to generate authentication logs when the API
connection has been configured.

3. Define the Base URL and select AWS Signature from the security type.
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4. Selecting it will make the following options available.

Access Key: The unique access key provided to the AWS user for authentication.

Secret Key: The corresponding unique key provided to the AWS user for authentication

AWS Region: The region from where the API connection is being made, set by the admin.

Service Name: The name of the AWS service being used in the API Connection.

Note: While the Access Key and Secret Key are unique to each user, the AWS Region and Service Name are common
among a group of users.
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5. Once the fields have been filled, click OK and the API Connection will be configured.

This API Connection can then be used in an API Client object to make API Calls to the resource.

6. Drag and drop an API Client object and configure it with the API Connection.
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7. Preview the output of the API Client object.

As you can see, the response has returned a ‘200 OK’ status.

This concludes the configuration and testing of the AWS Signature Authentication in Astera API Management.
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